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Introduction

Paragm Drive Copy 11 Professionahcludes allatest innovations imigration ofWindowsOSand data to different
environments With its help you can:

1 MoveyourWindows (any version since XR)m a reqular hard disk to a fasti3&olid State Drivelen of a
smaller capacity, thanks to advanced data exclusion capabie=edy yet completely indifferent to
mechanical impacESenables to get the mosiut of your system with minimal risk.

T Migrateyour system based on Windows Vista and later edititom an MBR disk tthe latest 2.2TBHDDon a
computercontrolled by the old BIO®pt the new UEFI (Unifidaxtensible Firmware Interface), thus taking
advantage of modernltra highcapacity hard driveen systemshat don't support it.

1 Pack up your Windows (any version since XP) to a special container fatdpleyment ona different
hardware configuratio® L G Q& G KS 0 Satifig HDDInAapteps, wHicB yiostdifeld dah
accommodate one hard disk only.

1 Augment32-bit Windows XP by adding support I8PT (GUID Partition Table) djgksis having the option to
transfer and store data on new internally connected ultra high capaeity drives.

1 Migrate your Windows (any version since XP) to a different hardware platiMinen upgrading to newer or
just replacing failed hardware use our unique P2P technology to guarantee startup of yieun sysa
dissimilar hardware configuration.

1 Transferyour Windows (any version since XP) to a virtual environneéiicrosoft Virtual PC, VMware
Workstation/Fusion, or Oracle VirtualBox (P2V)
Mostfunctio f AGe 2F (GKS LINRPRdzOG A& 2FFSNBR GKNRdAdAK KIyRe
inexperienced users can find it easy and efficient.

In this manual you will find the answers to many of the technical questions, which might ariseigihgethe program.

Our company is constantly releasing new versions and updates to its software, that's wt
images shown in this manual may be differefltom what you see on your screen.

7EAO0B8 O DridexCopy 11
1 Migrate OS to SSt» move any Windows OS since XP from a regular hard disk to a fast SSD (Solid State Drive
even of a smaller capacity, thanks tvanceddata exclusion capabilities.

1 GPT Loadem special system drivéo allow use of all space of modern ultra high caipadrives (larger than
2.2TB) on systenthat don't support it

1 The updatedCopy HDD Wizarthat now enable to successfully accommodate and startup any Windows OS
since Vista on a storage larger than 2.2TB in gha¢js connected to a computer controlled by the old BIOS, not
the new UEFI.

1 The updded P2V Copy Wizarth migrate alive Win2K+ physical system to a virtual environment of one of the
supported virtualization software vendors. In the latest version of the product the wizards enable to:

- Create and properly configure virtual machines adowg to your preferences. Depending on the selected
GANIidzl f ATFOGA2Y @OSYR2N) 82dz2Q@S 3I20G (GKS 2LIA2y G2
location, RAM to allocate, a disk controller, the guest OS, etc. So when the migration is de&rfydb 3 S {
only a virtual disk that contains an operating system and/or data, but a reEadge virtual machine.

/ 2 LI NX 3 R016 Paragod Biwvare Group. All rights reserved.



7

- Convert any combination of hard disks and partitions to migrate your entire computer or certain partitions
in one operation.

- Employ MS VSSd¢lume Shadow Copy Service) to synchronously migrate from several hard disks, thus
ensuring data consistency during online migration of a system, which seats on several partitions or hard
disks. This is achieved by taking a pairtime snapshot of the whle disk subsystem.

- 2KSY YAINIXrdAy3I FNRY aSOSNIf KFENR RA&lAZ | ff
letters in a virtual environment.

=N
N
N

1 The updated P2V Adjust OS Wizallows creatdn of virtual machines as well, so besides its primary function,
you can now build virtual machines out of supported virtual disks or Windows Vista/7 backup images.

1 The updated P2P Adjust OS Wizaodsuccessfly start up a Win2K+ physical system on a different hardware
platform (P2P) by allowing injection of all required drivers and the other actions crucial for this type of
YAINFI A2y d LyOfdzRAY3a (KS GKANR ISy SNiowdagzy 27F t I NJ

- Analyze all installed drivers inside a target system to report on devices without drivers.
- Search for and install lacking drivers from the builtWindows repository.

- Notify the user about boot critical devices without drivers (HDD/RAID cosrtsoketc.), automatically
prompting to provide a path to a driver repository.

- Name all devices according to their model description, not some alphanumeric code, which requires
additional deciphering.

- Determine and install drivers not only for boot criticelvices, but for physically connected NICs as well.
9 Automatic partition alignmentduring partitioning/copy operationt optimize performance of your hard disk.

1 Check FS Integrity and Data Loss Politielet you speify the acceptable balance between the operation
performance and the risk of data loss.

1 Conversion of basic MBR disks to basic @Pa&njoy all benefits of the newest partitioning scheme with
minimal effort.

1 WinPE 3.0 based bootable environmettt enjoy support of a wider range of hardware configurations with the
option to add drivers for specific hardware-time-fly.

9 The updated Boot Corrector for WinREat now equals the functionality of the Linux/DOS counterpatrt.

91 Support for Retained GP(Rlso known as Hybrid GPT), a special combined GPT+MBR patrtitioning scheme,
where the first three partitions except for EEBRT service patrtition) are synced between GPT and MBR. This
synced partition map provides an avenue, for instancefwting 32bit Windows Vista/7 on a 2.2TB+ d@k
O2YLJzi SNE O2yiNRffSR o6& GKS 2fR . Lh{owsonaGRTdISK a2

1 Support for exFAT (Extended File Allocation Table) file systeatkup, restore) developed byicrosoft
Corporation particularlyor flash storages. It supports drives up to 16 exbibytes, files much larger than 4GB,
larger cluster sizegtc.

1 Better support for HFSthat now includes not only resize capabilities, but create, format, and read only access
through our program as well.

9 Better support for64-bit platformsto rebootyour computer to one of the threepecial mods (Windows
native, Linux, or DOS) to automatically complepeeratiors, whichcannot be accomplished under &4
Windows.

1 AFD (Advanced Format Drive) ready

/ 2 LI NX 3 R016 Paragod Biwvare Group. All rights reserved.
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8
Support of 2TB+ and neB12B sector size drives
USB 3.0 ready

Product Components

In order to cope with differentasks, the product contains several components:

1

T

Windows based set of utilitiess the crucial part of the product. With the help of an easy to use launcher you
may find and run tasks of any complexity in thedfief data and system protection, hard disk partitioning and
cloning, etc.

Linux/DOS basedecovery environmenis a multiplatform bootable media that enables to run utilities under
Linux or PTS DOS, and that waydbagcess to your hard disk for maintenance or recovery purposes. Both
platforms have their strong sides, for instance Linux can boast support of FireWire (i.e. IEEE1394) or USB
devices. It enables to burn CD/DVD disks. However there can be some diffiauth detecting new hardware.
DOS inits turn has no problems of that kind but istéichin features. The Linux/DOS recovery environment
requires no installation and can be of great help when the system fails to boot. Besides it offers a Windows XI
like environment.

WinPE basedecovery environment Especially for keen followers of Windows, our product also offers a WinPE
3.0based baotable media. Unlikéhe Linux/DOS recovery environmeihtan boast an excellefardware

support and he same interfacasthe Windows versioican However its system requirements are much

tougher.

Features Overview

This chapter dwells upon key benefits and technical highlights of the product.

Features

Let us list some of thf=atures:

User Friendly Fault Minimizing Interface

9 Graphical representation of the datto gain a better understanding.

1 A handylLaunchero easily find and run the required tasks.

9 Comprehensive wizardw simplify even the mst complex operations.

1 A context sensitive hint systerfor all functions of the program.

1 Previewing the resulting layout of hard disks before actually executing operati(stscalled virtual
operations).

Copy Facilities

1 Migrate OS to SSt» move any Windows OS fronregularhard disk to a fast SSD (Solid State Drive) even of a
smaller capacity, thanks to advanced data exclusion capabilities.

1 Migrate to/from Containerto pack up a Windows systetm a special container for later deployment on a
different hardware configuration.

9 Partition/ hard disk copyto successfully transfer all esisk information including standard bootstrap code and

20KSNJ a28aidSY aSNBAOS aidNHz2OUdzZNBasz (Kdza YIAYyUdFAYyAy:
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9

A Copy functionality can also be used as an alternative way of data protection.

Virtualization Facilities
1 P2V Copyo migrate a Win2K+ physical system to a virtual envirent in the online mode.
1 P2V Adjusto recover the startup ability after unsuccessful virtualization with a 3rd party tool.

A Virtualization is the latest trend in the system migration, protection, and evaluation.

Partition/Hard Disk Management Facilities

9 Basic functions for initializing, partitioning and forntng hard disks(create, format, delete). Instead of the
standard Windows disk tools, the program supports all popular file systems.

1 Mount a partition (assign a drive letter) of any file system type to make it abviglfor your operating system.

1 Modify file system parameterg¢male active/inactive, hide/unhideetc.).

1 Undelete Partitions Wizardo recover an accidentally tkted partition.

Automatization Facilities

I Task schedulintgp automate routine operations. It can be particularly effective when you have to repeat a
sequence of actions on a regular basis.

A Scheduling is only available for the Windows installation of the program.

9 Scriptingto make the program create a script of any set of operatipms need. Besides support of all
operations available in the interactive mode, the unattended mode provides some additional features, such as
conditional execution, subroutines, repeatable iterations, disk/partition properties analysis, errors
managementetc.

Auxiliary Facilities

1 GPT Loadeis a special system drivéo allow use of all space of modern ultra high czipadrives (larger than
2.2TB) on systenthat don't support it

1 Conversion of basic MBR disksltasic GPTo enjoy all benefits of the newest partitioning scheme with
minimal effort.

9 Eile Transfer Wizartb make such operations as transferring of files/directories or burning of them to CD/DVD
as easy andanvenient as possible. Providing access to Paragon backups as regular folders, it may also help t
replace corrupted data from a previously created image in case of an operating system failure.

1 Volume Exploreis a hawly tool when you have different file systems on the disk, whether they contain an
operating system or just data. Volume Explorer will let you explore a file system of any type and provide acce!
to the necessary files and directories regardless of thaiusty attributes.

1 Recovery Media Buildeto create abootablerecoverymediabasedon Linux/DOS or WinEE)ona CD,DVD
disg or flash memorywhich can later be used to boot and recover your computeage®f an operating
system failure. Moreover, with its help you can save data from partitions of your hard disk directly to compact

/ 2 LI NX 3 R016 Paragod Biwvare Group. All rights reserved.
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discs or burn IS@nages. The utility supports various formats of laser discsR{EDV, DVER/RW, DVD+R/RW,
DVDR, DVD+R ddle layer, Bleray and can handle mul§ession burning.

Network Configuration Wizardo establish a network connection under LimuxXWinPEeither to save a backup

of a partition/hard disk or just several files ametwork computer or retrieve a previously made backup from a
network computer for recovery purposes.

Boot Correctorto fix most of the system boot problems that can be a result of a human factor, program error ol
aboot virus activity.

A

Boot Corrector i®nly available for the WinPB.0or Linux/DCS bootable recovery
environment

Supported Technologies

Along withusing innovative technologies from outside, Paragon has developed a number of its own original
technologies that make its products unique and attractive for customers:

1

Paragon Hot Copy technology to copyocked partitions and hard disks under Windows Kartily operating
systems providing both high operating efficiency as well as low hardware requirements.

t F NI 32y | RI Liachrdl8gy tes8ciastuldnigrate a Win2K+ physical system to a different
hardware platform (P2P)

t I NI 32y t 2 e@mnlody (o prévidikdata consistency in case of a hardware malfunction, power
outages or an operating system failure.

Paragon UFSDtechnology to browse partitions of any file system including hidden and unmounted, modify
and copy files and folders, etc.

PaNJ 32y wSaii2 NBchnalagy ti regtokeNMIbatkuptimage to a free block of smaller size taking into
account only the amount of actual data of the image.

Paragon BTE technology to set tasks for execution in the Windows blue screen mode, thus $arimthe
need to use a bootable media when modifying system partitions.

Microsoft Volume Shadow Copy ServiféSS) to provide the copy/backup infrastructure for the Microsoft
Windows XP/Vista/7/Server 2003/2008 operating systems. It offers a reliableamisoh to create consistent
point-in-time copies of data known as shadow copies. Developed by Microsoft in close cooperation with the
leading copy/backup solution vendors on the market, it is based on a snapshot technology concept.

GUID Partition Tabl¢GPY). It is the next generation of a hard disk partitioning scheme developed to lift
restrictions of the old MBR. GPT disks are now supported by Windows Vista/7, Server 2008, Mac OS X and L

RetainedGUID Partition Tabléalso known as Hybrid GP 3 spetal combined GPT+MBR partitioning scheme,
where the first three partitions except for EFI (GPT service partition) are synced between GPT and MBR. This
synced partition map provides an avenue, for instancebfmting 32bit Windows Vista/7 on a 2.2TB+ diwk
O2YLJziSNA O2y(iNRffSR o0& G(KS 2tfR .Lh{® LIQa I faz

Supported Virtual Machines

)l
)l
)l
il

Microsoft Virtual PC
VMware Workstation
VMware Fusion

Oracle VirtualBox
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11
Supported File Systems
1 Full read/write accestFAT16/FAT3@xFATpartitions.

91 Full read/write access to NTFS (Basic Disks) under Windows, Linux and PTS DOS. Compressed NTFS files ¢
supported.

9 Full read/write access to Ext2FS/ExtEx®FJartitions under all versions of Windows, DOS 5.0 atet.la

9 Limited read/write access to Apple HFS+ partitions.

Unfortunately, support of nonRoman characters for the HFS+ file system is unavailable
the moment. The company is about to implement it in the nearest future.

Supported Media
9 Support of both MBR and GPT hard digk&TB+ disks includgd
IDE, SCSI and SATA hard disks
SSDS%olid State Drive
AFD (Advanced Format Drive)
Non512B sector size drige
CDR, CERW, DVER, DVD+R, DMRW, DVD+RW, DVB) DVD+R double layer and alsoaludiscs
FireWire (i.e. IEEE1394JSB 1.0, USB 210SB 3.bard disks

=A =4 =4 =4 =4 -4 =4

PC card storage devices (MBR and GPT flash memory, etc.)

Getting Started

In this chapter you willifid all the information necessary to get the product ready to use.

Distribution
ParagorDrive Copyl1is distributed in two ways:

1 Boxedpackage from Paragon SoftwaBmbH and resellers

1 526y ft2FRF6fS LI O1I3S 20SNI6itKS LYyGSNySa ad GKS 02
Distri butive CD

The boxed package includes a distributive CD that is imfBobtable recovery environmemtith auto-run of the
Windows installation, thus it can be used asaredy RS a2 f dzG A2y ® . dzi A F &2 dzQNB 3;
you need tomstall them first (seénstallatior).

If you want to download an update/upgrade of the product, it will be in form of the downloadable installation package
as described i@nline Dstribution).

Online Distribution

Drive CopyL1purchased over the Internet will be in form of an MSI packader installing the product you can launch
the Recovery Media Builder fwepare arecovery medi.
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Registration

Paragon Softwar&mbH provides a wide range of online services through itspeetal - www.paragon
software.com/support!

1 Registration of new users;
1 Registration of purchased prodiscfor registered users;

1 Available aroundhe-clock downloading center, where registered users can get product updates/upgrades as
well as all the necessary documentation;

1 Downloadable free demo versions and open documentation for all users.

A It is recommended to use Internet Explorer 5+ or any compatible browser.

To register as a new user
To register as a new user, please do the following:

1. Run an Interet browser and visit the pag&ww.paragonrsoftware.com/myaccount

2. ClickCreateof the Create a Paragon Accouséction;
3. Fill out a registration form;
4. ClickRegister
The most importat field in the form is an{nail address, as it serves as a login to enter the system. Besides your acce:
password will be sent to this address as well.
To register a new product
If you are a registered user and would like to regifdrve Copyll, please do the following:

Run an Internet browser and visit the pagevw.paragonrsoftware.com/myaccount/

In the Emailfield of theAuthorization section, enter an #nail used for registridon;
In the Passwordield enter a password received after registration;

ClickSign in

If the user name and password are valid, you will get to your account;

ClickRegister new producof the Productssection;

N o o > w D

Enter your product serial number in tt&eral Numberfield. You can find it in the product box or obtain from
your reseller. Clicklext,

8. On the next page you will be asked to provide some additional data. Also you will need to decide whether you
want to get confirmation on registering the product Email or not. Clickext, and then clickinish

That is all. The product is now registered.

How to Download Updates/Upgrades
Downloading of updates/upgrades can be fulfilled in the following way:

1. Run an Internet browser and visit the pagevw.paragonsoftware.com/myaccount

2. In theEmailfield of the Authorization section, enter an nail used for registration;

3. InthePasswordield enter a password received after registration;
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ClckSign in
If the user name and password are valid, you will get to your account;
SelectMy Downloadsof the Productssection to see what updates are available for you;

Select the desired update and clidbwnload

Contacting Paragon Software GmbH

If youhave any questions about the company products, please do not esidtaontact Paragon SoftwatembH.

Service Contact

Visit Paragon GmbH web site www.paragonsoftware.com

Registration & updates welservie www.paragonsoftware.com/support

Knowledge Base & Technical Support kb.paragorsoftware.com

Pre-sale information sales@paragosoftware.com

System Requirements

For the Windows installation package

)l
)l
)l
)l
)l
)l
1

T

Operating systems: Window&P/Vista/7 and XP SP2/Vista/7-16i4
Internet Explorer 5.0 or higher

Intel Pentium CPU or its equivalent, with 300 Midacpssor clock speed
128 MB of RAM256+ recommended)

Hard disk drive with 100 MB of available space

SVGA video adapter and monitor

Keyboard

Mouse

For the Linux bootable environment

)l
1
)l
1
)l

Intel Pentium CPU or its equivalent, with 300 MHz processor clock speed
256 MB of RAM

SVGA video adapter and monitor

Keyboard

Mouse

For the WIinPE bootable environment

= =/ =4 =4

Intel Pentium Il CPU or its equivalent, with 1000 MHz processor clock speed
At least 512 MB of RAM

SVGA video adapter and monitor

Keyboard

Mouse
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Additional requirements
1 Network card to send/retrieve data to/from a network computer

1 External USB hard drive to store data.

Installation
To install Paragodrive Copy 1, please do the following:

1. Run Setup ApplicationClick on the *MSiI file. This application wguide you through the process of the
program installation. The setup utility is compiled with the InstallShield SDK, hence it contains the standard u:
interface and set of installation steps.

In case there is some previous version of the program installed on the computer, the
program will offer the user to uninstall it first.

2. Starting SetupThe Welcome page informs that the application is beintallesl. Click the Next button to
continue.

3. Confirm License Agreementhe License Agreement page displays the Paragon License Agreement. Read the
agreement and then select the appropriate option to accept. If you do not agree with any conditions stated
there, the installation process will be interrupted. By clicking the Print button, the License Agreement may alsc
be printed out.

4. Provide Registration InformationOn the Registration page you are to provide your product key and serial
number.

5. Provide Customelnformation. On the Customer Information page you are to provide the standard
information, i.e. a user name and an organization. Besides you need to decide whether to make the program
available for all users of this computer (if several) or only forctmeent one.

6. Select an Installation FoldeiThe Destination Folder page allows you to choose a folder where the program will
be installed. By default, the installation folder will be created as:

C\Program FilesParagon SoftwareParagonDrive Copyll. To$t SO0 Fy2 1 KSNJ F2f RSNE
button.

After you have selected the required folder, click the Next button to continue.

Do not install the progam on network drives. Do not use Terminal Server sessions to ins
and run the program. In both cases, the program functionality will be limited.

7. Confirm Installation On the Ready to Install the Program page click the Install button to start thelatista or
the Back button to return to any of the previous pages and modify the installation settings.

8. Copying FilesThe Copying Files page shows the overall progress of the installation. Click the Cancel button to
abort the setup.

9. Finishing the Installaon. The Final page reports the end of the setup process. Click the Finish button to
complete the wizard.

kernel mode hotcore driver, thus the system reboot is required to complete the installatit

: To accomplish online backup/copy of lockedmtitions/hard disks the program uses a
procedure.
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First Start

To start Paragobrive Copyl1 under Windows, please click the Windows Start button and then sBlexgrams >
ParagonDrive Copyt 11> ParagorDrive Copyt.

The program provides wide opportunities in the field of hard disk structure modification,
A just to be on the safe side,lpase make a backup of your data before carrying out any
operation.

The first component that will be displayed is called the Express Launcher. Thanks to a well-tutugiteégorization
and hint system, it provides quick and easy access to wizards #itidsithat we consider worth using on a regular
oFbairad 2AGK Ada KSfLI e@2dz Oy |faz2 adkNI dzLJ §KS (NI RA

&) Paragon Drive Copy™ 11 Professional o] O e
Paragon Drive Copy™ 11 L Sﬂparaeon
FJI( ‘ " ‘,l( '1()| [SOFTWARE GROUP]
o Migration Mlgrat|on

What would you like to do?

5! » Migrate Hard Disk

@ Adjustment Upgrade your hard deive by creating an exact copy from one to ancther hard dive
Please note if there is any content on the target disk it will be
overwritten.

f:t‘ Ty # Migrate to Virtual Machine

3 = I 1 I
— Troubleshootlng . Tra;!a!heoperangmunanddaafm your computer to a virtual machine

Capture and store your PC's cument state in a virtual environment

e Support Contacts # Migrate Hard Disk to Container

. Save exact clone of your hard disk to contaner which contains the complete system
and data structure of your existing hard drive. You can Migrate from Contanerto
ancther Hard Disk from Drive Copy 11 Advancad Recovery Disk.

# Migrate OS to SSD

. Clone an exact copy of your operating system to SSD drive. The cloned operating
system will be bootable. Please note f there is any content on the target SSD disk t will
be overwrtten

Q, Full Scale Launcher

To start up the traditonal Launcher please clickon Switch to Full Scaleauncher

t2 1y26 Y2NB 2y K2¢ G2 KIYyRfS G(GKS LINBnRA
please consult thaVindows Componentghapter.

Building Recovery Media
Recovery Media Builder can help you accomplish the following operations:

1 Prepare the Linux/DOS recovery environment (included in thallason package) on external media (CD, DVD,
or flash memory) to boot and run utilities under Linux or PTS DOS, and that way to get access to your hard di
for maintenance or recovery purposes (strongly recommended);

1 Prepare a custom Linux/DOS recovenyironment by adding any data you like to the standard image;
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1 Prepare a bootable recovery environment from any ISO image, including our @/thRtage (strongly
recommended);
1 Create from the master CD the Linux/DOS or WIinPE recovery environment on\&BC@4D, or flash memory.

Below you can find how to build our WinBIB based recovery environment on a thumb drive:

1. Plug in a thumb drive of at least 250 MBs in size. Please note all data on that drive will be deleted.
2. Launch theRecovery Media BuildefThere are several ways to do it:

f IntheMainMenu:seleat 22f a8 H wSO2FSNE aSRALl . dzA f RSNX

1 Onthe Common Tasks Bar: click Recovery Media Buildeitem of the Wizards menu.
3. On the Wizard's Welcome page, click the Next button.
4. Select the=lash Memoryoption.

@ HRash Memory

Select this option to create the recovery envionment on a flash memory media. Thus you will get al
recovery features avaiable in the program on a compact. reliable. and fast device frecommended)
CD/DVD

Select this option to create the recovery environment on 3 CD/DVD. Thus you will also get a bootable

CD or DVD with all recovery features avalable in the program (ndispensable in case your computer
does not support booting from USB drives)

5. Select theUser specified CD/DVD image (.iso fitgtion, then browse for an 1ISO image of our WisRE

recovery environment or manually type in a full path to it. By selecting@ thpical option you can build our
Linux/DOS recovery environment, which we highly recommend you to do as well.

Typical
Use the standard Recovery Media image suppled with the program
@ User specified CD/DVD image (.iso file)
Use CD/DVD image from specific location
E-/Downloads/Paragon/winpe20_BR10_Sute-eaam iso [ Browse
Copy from a CD/DVD
Choose a source CD/DVD drive

You can get an ISO image of our WirPENBE O2 OSNE Sy @ANRY YSyli
web service.

6. Select the required thumb drive from the list of flash memory devices available in the system at the moment (i
several).

Forailable dives:

. Drive Supported Formats

7. You will have to confirm the operation.
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WARNING: As a result of this operation ALL DATA on the flash memory media will be ERASED.
Click "OK" if you agree or ‘Cancel' if you do not.

1; 0K Cancel

Booting from the Linux/DOS Recovery Media

The Lmux/DOS recovery environmeoan be used to boot your agputer into Linux or PTS DOS to get access to your
hard disk for maintenance or recovery purposésiso haghe PTS DOS safe mode, which may help in a number ef non
standard situations such as interfering hardware settings or serious problems on th&ararlevel. In this case, only
basic files and drivers (such as hard disk drivers, a monitor driver, and a keyboard driver) will be loaded.

Startup
To start working with the Linux/DOS recoverywironment please take the following steps:

1. Start up the comuter from our Linux/DOS recovery media.

Recovery Media Buildetan help you prepare the Linux/DOS oriNPE recovery
f environment either on a CD/DVD disc or a thumb drive.

To automatically boot from the recovery media please make sure thebmard BIOS is set
up to boot from CD/USB first.

2. Launch a boot mode you need (Normal, Safe,-Graphics Safe) in tHiBoot menu.

A By default the Normal Mode will be automatically initiated after a 10 second idle period.

3. Click on the required operation to start. Hints the selected at the moment item whklp you make the right
choice.

4. Consult the help system by pressifigT+F1o know more on the subject.

Boot menu

The Boot menu contains the following commands:

-« Hormal Hode Main recovery
& Safe Mode environnent

& Lou-Graphics Safle Mode

& Floppy disk

& Hard disk B HER

& Find 05es on your hard disks

1 Normal Mode Boot into the Linux normal mode. This mode uses tlies@t of drivers (recommended);

I Safe Mode Boot into the PTS DOS mode. This mode can be used as an alternative of the Linux ndaniiit mo
fails to work properly;

1 Low-GraphicsSafe Mbde. Boot into the PTS DOS safe mode. In this case, only the minimal set of drivers will be
included, like hard disk, monitor, and keyboard drivers. This mode mgdesgraphics and a simple menu;

1 Floppy DiskReboot the comuter from a system floppdisk;
1 Hard Disk OBoot from the primary hard disk;
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9 Find OS(s) on your hard diskBhe program will scan hard disks of your computer td &ény bootable operating
system.

To move within the menu, please use the arrkgys of the computer keyboard.

While working with the recovery environmenyou might experience some inconvenience

caused by possible video artifacts. It is just a result of changing eid®des and in no way

will affect the program functionality. If this is the case, please wait a bit and everything w
be OK.

Normal Mode

When the Normal mode is selected, the Linux launch menu appears:

Q= You can copy an entire hard disk or its
Paragon Drive Copy™ partitions 1 new locations, You can also save
them 4% image fibes for laer resmaraton

Flease select the drive, its partition i
necessary, and then activate the Hard Disk’ or
Parition” pull-down menu and select the

Disk Copy Wizard operation nesded.

£, Simple Restore Wzard

File Transfer Wizard
Boot Corrector

Log Saver

Eject CO/DVD

Reboot the computer

SR - [N

Power off

9 Drive Copyenables to copy and back up separate partitions oirertard disks, carry oytartitioning
operations, etc.);

1 Simple Restore Wizarthllows restoring hard disks and partitions);

91 Disk Copy Wizar¢helps to clone a hard disk);
Fle Transfer Wizardallows coping files/folders to another disk or a partition as well as recording them to
CD/DVD);

1 Boot Corrector(helps to correct the Windows System Registry without Windows being loaded);

1 Network Configurator(enables to establish aetwork connection under Linux);

If you are going to use network resources, first launch the Network Configuration Wizarc
establish a network conneabn.

1 Log Savethelps to collect and send the necessary log files to the Technical Sypport)

1 View the mounted partitions(the list of all mounted partitions will be displayed);

DOS, i.e. one after another, primary partitions at first. Thus mounted partitions may hawvi

j The Linux/DOS recovery environment assigns drive letters to partitions the way it is don
different drive letters from Windows.
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1 EjectCD/DVD
1 Reboot the computer
1 Power off the computer

To move within the menu, please use the arrow keys of the computer keyboard.

Safe Mode

When the Safe mode is selected, the PTS DOS launch menu appears. It has nearly the same functionality as for the
Nomal mode except thé&etwork Configuratorand Log Savecommands. Besides due to certain limitations of the PTS
DOS environment, there is no podktis to burn CD/DVD disc

Low Graphics Safe Mode

When the Low Graphics mode is selected, the PTS DOS laenchappears. It has the same functionality and looks
similar to the Safe mode but graphically simpler.

SETTEETTE S | vou can create, delete and

# Simple Restore Hizard format hard disk partitions

#® Disk Copy wizard using this program, which

Bl File Transfer Hizard will start now.

[E Boot Corrector Upon the start, please
select the drive and one of

8 Reboot the computer its partitions or its free

space. Then activate the
'Partition’ pull-down menu
and select one of the
partitioning operations.

Booting from the WIinPE Recovery Media
The WInPE recovery environment can be a reatadtive to the Linux/DOS recovery environment. Providing nearly the
same level of functionality it offers an excellent hardware support and the same intexfdice Windows version does.

Startup

To start working with the WIinPE recovery environment, pldake the following steps:

1. Start up the computer from our WIinPE recovery media.

Recovery Media Buildetan help you prepare the Linux/DOS or WinPE recovery
2 environment either on a CD/DVD disc or a thumb drive.

To automatically boot from the recovery media please make sure thebmard BIOS is set
up to boot from CD/USB first.

2. Onceit has been loaded, youilvsee the License Agreement. Read the agreement and then mark the
appropriate checkbox to accept. If you do not agree with any conditions stated there,¥gu@iG o©S I o
the program.
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Press Page Up and Page Down to scroll the text

End User License Agreement ﬂ
bétween

PARAGON Software GmbH,
Heinrich-von-Stephan-Str. 5 ¢, 79100 Freiburg, Germany,

and

You, as end user

If you accept the terms of the agreement, click the check box below

W&wmmmmmw ]

g | peane |

3. Once you accept the agreement, you will see the Universal Application Launcher. In general it enables to run
components of the product, load drivers for undefined hardware or establish a network connection.

Paracon

SOFTWARE GROUP

Paragon Drive Copy™ 11 ' | )S‘

Migration
What would you like to do?

. * Migration

@t} Adjustment ‘ Migrate Hard Disk
' Upgrade your hard drive by creating an exact copy from one to another hard dive. Please
ellhetzlswculmonthelmdlklwlbeovemmlm

b

# Migrate to Virtual Machine
\ Move the operating system and data from your computer to a vitual machine, Capture and store

=
6 Support your PC's cument state in a vitual environment

Tools

Contacts ‘ Migrate Hard Disk from Container

Migrate to new hard disk from praviously created Contaner, Please note ff thera is any content
on the target disk ¢ will be ovenantten.

R Full Scale Launcher Restad [8) Shutdown

4. Click on the required operation to start. Hints on the selected at the moment iterhelilyou make the right
choice.

5. Consult the help system by pressiigT+F1o know more on the subject.

A Our WinPE3.0 based recovery environment offers excellent hardware support. However
OFrasS Al R2SayQi KIS I RNAGDGSNI F2NJ &2 dzNJ
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Pleaseconsult theAdding specific driverscenario to know how to tackle this issue.

Basic Concepts

This chapter explains terms and ideas that show how the program works. To understand these helps to obtaiala gen
notion of the operation performance and makes it easier for the user to operate the program.

Paragon Hot Processing & Volume Shadow Copy Service

Offline versus Online Data Processing

In the course of time there have been developed various methods af plaicessing. Despite different work concept,
all of them can be divided into two principal groups: offline (cold) and online (hot) data processing techniques.

As the name infers, offline data processing can only be accomplished when the data is irrobsa&ist (the operating
system and all the applications are completely shut down). Actually it is the most preferable way of image creation or
data cloning, since software can obtain an exclusive right to process data that guaranties high level afgperati
efficiency. However, the offline data processing is absolutely out of question when dealing with 24/7 production
environments.

In contrast, online data processing enables to create a consistent snapshot even as the data is currently modified. It |
parth Odzf | NI & dzaSTdzZ F2NJ a2aidiSvya gAGK KAIK | GFAtFoAfAGe
transactions are complete. The point is to provide a coherent state of all open files and databases involved in a proce
taking into account tht applications may still keep writing to disks. As a result an online data processing cannot boast
high operating speed.

Our program supports both offline and online methods of data processing. As far as online method is concerned it off
its own hot pocessing algorithm together with the possibility to use snapshot technologies provided by the Microsoft
VSS framework.

Paragon Hot Processing Technology

Paragon Hot Processing is an online copy/backup technology for Windows NT+ family operating systelmzede
back in 2001, nowadays it is integrated with all copy/backup solutions offered by the company.

Paragon Hot Processing is not exactly a snapshot technology, though it has much in common with it. During an onlin
copy/backup, the program uses the kel mode driver HOTCORE.SYS to intercept and control disk write activity of
applications and the operating system. The hotcore driver as an integral part of the program is installed during the se
LIN2E OSRdzZNBE o6 G KIFGQa ¢Ke ( kpletdthelsétup Wrochddra)2Fariihe mast pitiShe deveXiB iR
the idle mode until it is activated with the program. While in this mode it bypasses any calls having no effect on the
overall system performance, but a few kilobytes of the system memory.

Pamgon Hot Processing technology offers copy/backup of locked partitions and hard disks under Windows NT+ famil
operating systems providing both high operating efficiency as well as low hardware requirements.

Volume Shadow Copy Service

Microsoft Volume Shamlv Copy Service (VSS) is designed to provide the copy/backup infrastructure for the Microsoft
Windows XP/Vista/Server 2003/2008 operating systems. It offers a reliable mechanism to create consistént point
time copies of data known as shadow copies. Diyed by Microsoft in close cooperation with the leading

copy/backup solution vendors on the market, it is based on a snapshot technology concept.
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Initiated by a VSS aware copy/backup utility, VSS creates snapshots for the selected volumes and répeesasts
virtual readonly devices, called volume shadow copies. Once the shadow copies are created, the copy/backup utility
starts processing the data while applications keep writing to original volumes.

Unlike Paragon Hot Processing the VSS technologyde®a unique possibility to make a synchronous snapshot of
multiple volumes. This very feature can be particularly beneficial when backing up active SQL Server 2003, Exchang
2003 or Oracle databases located on multiple volumes the way it is recommégddetrosoft to improve the level of
database performance and reliability, thus providing {f@@cent data consistency.

A To use VSS it is necessary vk a mounted 300 MB+ NTFS partition.

GPT versus MBR

GUID Partition Table (GPT) is the next generation of a hard disk partitioning scheme developed to lift restrictions of t
old MBR. Being a part of the Extensible Firmware Interface (EFI) standardedappintel to replace the outdated PC
BIOS, it offers a number of crucial benefits:

1 Up to 128 primary partitions for the Windows implementation (only 4 in MBR);

1 The maximum allowed partition size is 18 exabytes (only 2 terabytes in MBR);

1 More reliable thanks to replication and cyclic redundancy check (CRC) protection of the partition table;
1

A well defined and fully seilflentifying partition format (data critical to the platform operation is located in
partitions, but not in urpartitioned or hidden sect as this is the case with MBR).

To tackle compatibility problems with older operating systems there has been introduced a special combingilBRPT+
partitioning schemealled Retained GPT (also known as Hybrid GPT), where the firsptrtéons excepfor EFIGPT
service partitionare synced between GPT alWBR.Thissynced partition map provides an avender instance for
booting320 A i 2 AyR2ga zAaildlkt 2y 02 YLlzi S N&rd@Pogoling®at ®SSFando &
Windowson aGPT disk

64-bit Support

The bulk of software today is written for a-B& processor. It can meet the requirements of almost any end user.
However that is not the case when dealing with servers processing large amounts of data with complex calotfilations
very large numbers. That is where-B# architecture comes into play.

It can boast improved scalability for business applications that enables to support more customer databases and moi
simultaneous users on each server. Besides-bittkernel can acess more system resources, such as memory
allocation per user. A 6Mit processor can handle over 4 billion times more memory addresses thaiia @dcessor.

With these resources, even a very large database can be cached in memory.

Although many busiess applications run without problems on-BR systems, others have grown so complex that they
use up the 4 GB memory limitation of a-BR address space. With this large amount of data, fewer memory resources
are available to meet memory needs. On al¥dserver, most queries are able to perform in the buffers available to the
database.

Some 32bit applications make the transition to the @4t environment seamlessly others do not. For instance, system
level utilities and programs that provide direcrdware access are likely to fail. Our program offers dlaedged
support of the 64bit architecture providing faultolerant work for such system dependent modules as Hot Processing.
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Copy Operations

Hard drive duplication nowadays is becoming highlgydar among PC users. That is due to some definite advantages it
can offer. First of all, many people clone hard disks just to back up data for security reasons. The present day copy
utilities enable to successfully transfer all-disk information incluaig standard bootstrap code and other system
ASNIDAOS aiNWzOGdzNBazx GKdza YIFAYGFAYyAy3a GKS 2LISNF Ay 2
can get the system back on track in minutes. No additional configuration is requiredismeay convenient.

The second possible application is the upgrade of a hard disk to a new one. The capacity of a modern hard drive dot
every two years, thus opening up new possibilities for software developers. As a result programs become more
complicated and require considerable amount of free space. One day the user realizes that there is no more free spa
left on the hard disk and the only way out is to upgrade. Usually that means that besides purchasing a new hard disk
the user is to face a laegre-installation procedure spanning several days of tedious work. But all of this can be avoidec
just by copying the contents of the old hard disk to a new one proportionally resizing the partitions.

And the last but not least is the copying of hard difskscloning purposes. It may be of great use when setting up
similar computers. There is no need for a system administrator to install an operating system from scratch on every c
of them. It is enough just to configure one and then clone it to the ather

Drive Partitioning

As you probably know a hard drive is to be split into one or more patrtitions, since it cannot hold data until it is carved
and space is set aside for an operating system. Until recently most PCs used to have just one partiticiil|edhihe

entire hard disk and contained an OS. The situation has changed however, thanks to neffectise high capacity

hard drives, thus opening up numerous possibilities for PC users, such as editing video, archiving music, backing up
images etc. Huge increase in space is great, but it poses a number of problems, most important of which are effective
data organization and speed.

Large drives are always going to take longer to search than smaller volumes, and an operating system is @eerigsto h
work cut out both finding and organizing files. It is for this reason that many people decide to invest in multiple hard
drives, but there is an easy solutiqmrive partitioning. Partitioning lets you divide a single physical drive into a number
of logical drives, each of which servers as a container with its own drive letter and volume label, thus enabling the
operating system to process data more efficiently. Besides partitioning makes it possible to organize data so that it is
easy to find anananage. You can set aside, for instance, 40 GB of a 160 GB hard drive for the OS, 70 GB for storing
video and another 50 GB for your favorite music collections to provide transparent data storage.

It is also worth mentioning to that with a hard drive prajyepartitioned, such routine operations as files-de
fragmentation or consistency check will not be that annoying and-tioresuming any more.

By detaching the OS from the rest of the data you can tackle one more cruciat isscase of a system malfutin,
you can get the system back on track in minutes by recovering it from a backup image located on the other partition
the hard drive.

But that is not all drive partitioning may be used for. If you are willing to play games in Windows while brinesing
Internet in Linux, 10@ercent sure that no virus will attack your PC, drive partitioning is a necessity. In order to run
several OSs on a single hard drive you are to create a corresponding number of partitions to effectively delineate the
boundariesof each OS.

Scheduling

The automation of operations is particularly effective when you have to repeat a sequence of actions on a regular ba:
For example, developing a specific project on aftaglay basis and having to make a backup every evening sotdo
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lose the valuable data, you will really appreciate, when this kind of routine operations will be carried out automatically

without your participation.

l'Y20KSNJ FaLISOoG 2F lye Fdzi2aYlGA2Yy LINR OSa ark-laad. Thisksk G A
especially important when operations require a considerable amount of computer resaypresessor time, memory
and more. A number of tasks, which can decrease the performance, can be run during the night or whenever the
computer has thdeast workload to perform.

The program has a special tool for scheduling. You can set out a timetable for any operation and it will start at a
specified time without interrupting your current activity.

Windows Components

In the given section you can firadl the information necessary to successfully work with the Windows version of the
product.

Interface Overview

This chapter introduces the graphical interface of the program. The design of the interface precludes any mistake bei
made on the part of theiser. Most operations are performed through the system of wizards. Buttons and menus are
accompanied by easy understandable icons. Nevertheless, any problems that might occur while managing the progr:
can be tackled by reading this very chapter.

General Layout

When you start the program, the first component that is displayed is called the Launcher. It enables to run wizards ar
dialogs, to specify program settings, to visualize the operating environment and the hard disk configuration.

¢ KS [ I dzy O &R &onditibngliR Qubdivided into several sections that differ in their purpose and
functionality:
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@M&Wa M Main Menu

Toolts Changes Wizards Hard Disk Partition View

vRODHAE |&|8®
N - Disk

Operations Bar

151 Basic Hard Disk 1 (VMware. Viware Vieual § SCS1 Disk Dev)

| «

(11 No changes.

1. Main Menu
2.Tod Bar

3. Virtual Operations Bar

4. Common Tasks Bar

5. Explorer Bar
6. Disk Map

7. Partition List
8. Properties Bar

9. Legend Bar
10. Status Bar

A number of panels offer similar functionality with a synchronizeduayThe program enables to conceal some of them
to simplify the interface management.

All panels are separated by vertical and horizontal expandable sliders, allowing the user to customize the screen layc

Main Menu
The Main Menu provides access to tatire functionality of the program. The available functions are as listed below:

MENU ITEM FUNCTIONALITY

Tools
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View Log Files View logs on the carried out operations
RecoverU - AAEA " O| Restore the system even when the current operating system cannot boot
anymore

&E1T A 40AT O&A O | Transfer data from any media

Settings... Edit the geeral settings of the program
Exit Exit the program
Changes

"t AT AOAOA 3 A OE B Generate a script for the task

3AOA O1 3 AEAAQJ Schedule pending operations

Undo “the last virtua | Cancel the last virtual operation on the List of Pending Operations
operation®

Redo “the last virtual Cancel the last undo virtual operation on the List of Pending Operations
operation®

6 EAx #EAT CAO8 | Display the List of Pending Operations

Apply Changes Launch the real execution of virtual operations

Discard All Changes Cancel all virtual operations on the List of Pending Operations
Reload Disk Info Refresh the current information about disks

Wizards

Create Partit ET 1 8 Create a partition of any file system

&1 Ol AO 0 AOOE OH Format a partition of any file system

$ AT AOGA 0 A OOE OH Delete a partition of any file system

51 AAT AOA 0 A OOH Recover an accidentally deleted partition

0c6 #1 PUS Migrate a live Win2K+ physicafstem to a virtual environment

P26 | AEOOO [/ 38 | Make Windows Vista/7 backups bootable on virtual hardwaseover the
startup ability after unsuccessful virtualization with"&arty tool

#1 DU (AOA $ E OH Create a hard disk copy

SAEAAOI A (AOA | Setatimetable for a hard disk copy

#1 DU 0AOOEOET 1| Create a partition copy

BAEAAOI A 0 A OOE Setatimetable for a partitio copy

Hard Disk
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#1 1 OA0OO O1 " AQ

Convert a dynamic MBR disk containing simple volume(s) into a basic MB

Convert to Basic MBR hard
AEOES

Convert a basic or aygdamic GPT disk containing simple volume(s) into a bg
MBR disk

Convert to GPT hard disk

Convert a basiMBR disk int@ basicGPT disk

Update MBR

Update MBR (Master Boot Red) of the selected hard disk

00I PAOOEAOS

Get indepth information on the properties of selected hard disk

Partition

# OAAOA 0 A OOE OH Create a partition

&1 O AO 0 AOOE OHF Format a partition

$ AT AGA 0 A OOE OH Delete a partition

Il OOECIT $OEOA | Assign drive letter to the selected pigion

2AT 1T OA $OEOA

Remove drive letter for the selected patrtition

(EAA 0AOOEOEIT

Make the selected partition unavailable for the operating system

Make the selected partition available for the operating system

Mark Partition as Active

Make the selected partition bootable by default

Mark Partition as Inactive

Make the selected partition nchootable by default

#EAT CA 611 6i A

Change volume label of the selected partition

Check File System
I OACOEOQOUS

Check the selected partition for possible file system errors

00i PAOOEAOS

Get indepth information on the properties of selected partition

View

Layouts Manage the Launchdayout with several predefined profiles

Toolbar Manage the Tool Bar representation: show / hide standard and navigation
buttons, text labels and large icons

Status Bar Display the Status Bar

Common Tasks Bar

Display the Common Tasks Bar

Disk Map Legend

Display the Disk Map legend

Properties and Commands

Display the Explorer Bar

Disk Map Location

Select whether the Disk Map will be located on the top of the main window
at the bottom
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Help
Help Open the Help system (you can also do it by pressihg F1
About Open the dialog with information about the program

ﬂ The Main Menu contents available at the moment may vary depending on the selected
object.

Tool Bar

The Toolbar provides fast access to the most frequently used operations:

BUTTON FUNCTIONALITY

[0 Copy a hard disk

<]

-'?"@ Open the Help system
\$

Virtual Operations Bar

The program supports previewing the resulting layout of hard disks before actually executing operaticalte(so
virtual mode of exeation). In fact, when the virtual mode is enabled, the program does not accomplish operations
immediately, but places them on the List of Pending Operations for later execution.

The Virtual Operations Bar enables to manage pending operations.

BUTTON FUNCTONALITY

/L_\”_ij Cancel the last virtual operation on the List of Pending Operatior
@‘\ Cancel the last undo virtual operation on the List of Pending
Operations

Display the List of Pending Operations

Launch the real execution of virtual operations

Carcel all virtual operations on the List of Pending Operations

X|&

Virtual mode is an effective way of protection from any troubles, since no operations wi
be executed until clicking the Apply button for confirmation, thus giving a second chance

A weigh all pros and cons of this or that particular operation. The program politely reminds
the user that there are unsaved changes by showing the following vaiwd
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I There are unsaved changes.

Please use the Apply command to comre the changeas and the )‘( Discard
command 1o permanently undo the changes

You can view the changes history via the . View Changes command and

temporarily undo of redo the oparation by means of the " Undo and " Redo
commands

Common Tasks Bar

The Common Tasks Bar is located on the left side of the main window. It is intended for easy access to the program'
wizards.

The bar contains several tatf&ch tab includesa separate button bar which can be folded by clicking it.

Basic Partitioninglrasks

EJ_Q Craste Parition Starting the Create Partition Wizard to create a partition of any fitesy.
g{f Format Parttion Starting the Format Partition Wizard to format an existing partition to one of t
7y

file systems supported by the program.

% s e Starting the Delete Partition Wizard to delete a partition of any file system.

Advanced Partitioning Tasks

@ Undelete Paxtiions Starting the Undelete Pations Wizard to recover accidentally deleted partition

Copying Tasks

[(:i Copy Disk Starting the Copy Hard Disk Wizard to copy a hard disk.

(3 Copy Parttion Starting the Copy Partition Wizard to copy a partition.

Tools

Starting the File Transfer Wizard to transfer data from any media. Besides it
provides access to Paragon backups as regular folders to browse through thg
contents or copy required files.

- File Transfer Wizard

Helpand Documentation

{? Drive Copy™ Help Launching the help system (you can also do it bgging F1).
\“:fl About Drive Copy™ Opening the page which contains information about the program. This page

be displayed in the Explorer Bar.

E_ﬁj Seript Manual Opening a brief review on the Paragon Scripting Language.
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Disk Map

The Disk Map is displayed in te&plorer Bawhen the Disk View tab is selected. It is located either at the top or at the
bottom of the window, depending on the state of the Disk Map Location option (Main Menu: View > Disk Map
Location).

As the name infers, the Disk Map displays the layout of physical and logical disks. Physical disks are represented wit
rectangle bars that contaismaltsized bars. These smalked bars represent logical disks. Their color depends on the
file system of the appropriate partition.

-

Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev)

Local Disk (C:)
4395 GB NTFS

Largesized bars display the following information aboutpttal disks:

1 Manufacturer,

1 Model.
Smallsized bars display the following information about logical disks:

M Serial number,

9 Drive letter,

M Total size,

1 File system.
CdzNI KSNXY2NB>X Al Aa LRaarotsS G2 SaidaiyYl (shded &&. ThspHarR A 3
2FFTSNB (2 OK22aS8S FTNRY aSOSNIt GewlSa 2F GKS RA&l fl @&z
AyaillyOoSz AT &2dz2Q@S 320G | KAIK OF LI OAGe KI NRma jeksdS (
than 10 GB) partitions, you can select the logarithmic type to make all partitions readable, otherwise (selecting the
fAYSEFNI GelLlSv e2dz 62y QG o6S FofS G2 4SS avlrftf LI NUGAGAS?Z
layout is critical for you, the linear type is exactly what you need.
bSOSNIKSt Saa GKSNEB Qlinealscaling Withii@ nvidini@lSimitt2stalzipaktifioyis. So if a partition is
too small it will remain readable.

Just click on the arroweon on the top right side of the Disk Map to select the desired scaling type.

v Linear
Limear S5caling Min Width

N

=

Lirnex Ext4 ReiserFS

Disk Map is synchronized with the Explorer Bar. Thus by selecting a disk on the Disk Map, the Expldier Bar w
automatically display detailed information on it.

The dragand-drop functionality is not available when the logarithmic type of the disk
layout isselected.
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Explorer Bar

The Explorer Bar is located in the center of the main window which emphasizes its importance. The bar displays
reference information including:

1 The help system;
1 General information on the product including its name, version angt aflihelpful links;
1 Detailed information about disks selected on thesk Map
9 List of scripts;
9 List of scheduled operations;

1 Volume Explorer utility.
According to these categories the Explorer Bar has several tabs:

91 Disk Viev, which offers the user the following options:

- Partition Listo get a cleaicut picture of the current state of the system hard disks/partitions;

- Volume Exploretio browse andexport contents of the selected partition/hard disk;

- Propertiedo view detailed information on the selected partition/hard disk in the bright graphical form.

You can switch between these three components by clicking tabs on the left side of the
Explorer Bar.

1 Scheduled Tasksvhich gives the user the possibility oblrsing and editing scheduled operations and the
program scripts.

91 Help, which contains the program help and general information on the product.
You can access the desired information by clicking on the appropriate tab.

The Explorer Bar is a fullynctionalembedded HTML browser, which offers the possibility to address, for example, the
company's website to look through important technical notes or download the latest updates without having to close
the program.

The program help is also HT¥tiented. You an read it and follow external links from to get additional information.

To easily navigate through browsed pages, the program provides the following functionality:

BUTTON FUNCTIONALITY

Return to the previously browsed

(<)

) page
wﬂ Open the next browsed page
5% Stop loading the current page

Refresh the contents oht current
page

Partition List

The Partition List is another helpful tool that enables you to get a-clebpicture of the current state of the system
hard disks/partitions. Partitions are sorted according to their starting position. For every itdm 6§t there is the
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possibility to call the contex¢ensitive popup menu with available operations. Besides, the program provides detailed
information on all hard disks/partitions found in the system including the following properties:

- Name,

- Volume label (if exists),

- Partition type (Primary/Extended /Logical),
- File system type,

- Size,

- Amount of used and unused (free) space,
- Start/End cylinder,

- Start/End head,

- Start/End sector

- Free size in sectors/bytes

- Active/Inactive attribute

- Hidden/Unhidden attribute

You may customize outlook of the Partition List by clicking on the arrow icon on the top right side of the panel.

@} Pleaze select properties to display.
Please select properties you would ke 1o display in the Disks and Partitions view

Hame
Size fsectors
F5 Size (sactions
Used jsactors

4 m
SET0MN

m
3 e

| () () ) ] | |,
(0]
B

!
=1
=)
&

By marking a cheblox opposite the required item you can choose whether to display it or not. Besides, you can chang
its order by pressing the Move up or Move down buttons.

LT &2dz R2yQid ySSR (KS 5Aaal al Ll LX SrasS OtAaAd] (KS &Kz
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Properties Bar

The Properties Bar provides information on the selected at the moment partition/hard disk:
For a hard disk

1 Model,

1 Serial number,

1 Type of hard disk (basic or dynamic),

9 Total size (in GB),

1 Information on geometry of the disk (amount of sectors per track, heads and cylinders).
For a partition

9 Drive letter assigned to the disk,

1 Volume label (if available),

1 Type of the logical disk,

1 File system (represented by the color of the graph and the salduae),

1 Total size, used space and free space (in GB or MB).

Besides you can modify practically any partition property by clicking on the required value.

Legend Bar

The Legend Bar explains the color scheme used for disk and partition presentation. Ysedan show) the bar with
the appropriate Main Menu item: View > Disk Map Legend. When it is activated it can be found at the bottom of the

Explorer Bar
The program distinguishes between the following types of kndlersf/stems:

- FAT16/32,
-NTFS,

- Linux Ext2/84,

- Linux ReiserFS,
- Apple HFS.

Status Bar

This is the bottom part of the main window. The Status Bar displays menu hints, for each item the cursor points to.

The user can hide (or show) thar with the appropriate Main Menu item: View > Status Bar.

/ 2 L3 NX 3 R016 Paragod Blwvare Group. All rights reserved.



34
Settings Overview

The Settings dialog is available from the Main Menu: Tools > Settings. All the settings are grouped into several sectic
which functions are described in the following paradrapThe list of sections is placed on the left side of the dialog. By
selecting a section from the list, you can open a set of options.

c To get a detdied description to any setting, control, or field of the program just click the
hint button and then the object you need.

General Options

Qf -
7 g General options

Partition Algremsnt Mode

Vista -]
Align partitions according to the ndes used in Windows Vista and later O5es.
Check FS integrity policy

Oz -

Standard protection from data loss with acceptable peformance. The file:
sy=tam intagrity will be checked for each volume only once just befor
accomplshing data-ssnsitive operations.

Dats Loss Protaction made
Reset -
Meadium protection from data boss

This section contains a set of genavptions that will be taken into account during any operation carried out with the
program:

9 Partition Alignment mode There are three options you can choose from:
- Legacy5h{ YR 2AyR2ga h{Sa o0ST2NB +Aaidl NBAII NBRI X
or 63 sectors to address and access sectors correctly. It was OK, until 4K hard drives came into scene. W

partitions are aligned this way on this type of disk, each logical cluster is linked to two physical 4K clusters
thus resulting in @louble readwrite operation.

- Vista Since Windows Vista, operating systems do not use the archaic CHS (cylinder/head/sector) address
scheme, but the Logical Block Addressing (LBA), where sectors are addressed continuously over the who
disk drive. lis optimal for both, 512B and new 4K disk drivers.

- Inheritance Select the option to disable automatic alignment of partitions.

1 Check FS integrity policAccomplishment of any datensitive operatiorfresize, move, merge, redistribute,
changeclustersizetc)h & LI GSY ALt GAGK RFEGF f2a3ad ¢2 YAYAYA
82dz2NJ FAfS aeaidSY oST2NBE GKAA GeL)S 2F 2LISNIGA2yas
several options to let you choose, which &sbfor you:

- Always Maximum protection, but minimal performance. The file system integrity will be checked each time
AliQa ySOS&aalNE (2 3Idz NI yiSdskdateS YI EAYdzy LINRGSO

- Once Standard protection with acceptable performance. The fiigtam integrity will be checked for each
volume only once just before accomplishing daensitive operations.

- Neverb2 LINPGSOGA2YyYX odzii YIFEAYdzY LISNF2NXIYyOSo LT @
not use this option.
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1 Data Loss Proteatin mode To guarantee safety for your information when a daémsitive operation has been
abruptly interrupted as a result of a computer reset, or a power outage, there are several techniques, that
correspond to the options below:

- Donotprotect NoproteDi A2y = odzi YI EAYdzY LISNF2NXYIyOSod LT &z
from a power outage, or an accidental reset of your computer, please do not use this option.

- Reset Standard protection with acceptable performance. Maintaining a special guonr program
enables to automatically complete a datansitive operation interrupted by an accidental reset of your
computer from our bootable recovery media, thus reviving the corrupted partition.

- Power lossMaximum protection, but minimal performaec Besides journaling, our program will also
disable cache of your disk when accomplishing d&tasitive operations to avoid data loss even in case of a
power outage.

General Copy and Backup Options
[;}? General copy and backup options

Hdd raw processing

Copy an entirs hard disk sector by sector without taking into account its
parttion structure

Partttion raw processing

Copy/Backup each partition sector by sector. Al sactors wil be processed
one by one {even unused sectors). Requires more time to complete the
operation

V! Skip OS awdiary fles

Choose this option to skip OS awdkary files (ke pagefie sys, hbedi sys etc ),
This will reduce operation time and backup image size

This section contains a set of options that will be taken into account during copy and backup operations:

1 HDD raw processingMark the checkbox to copy/back up a hard disk in the sdayesector mode, thus
ignoring its informatio structure (e.g. unallocated space or unused sectors of existing partitions will be
processed as well). This can help to avoid problems with hidden data created by certain applications or the
system administrator. However, it will take more time to accdistpthe operation.

9 Partition raw processingMark the checkbox to copy a partition in the seebgrsector mode to successfully
process unknown file systems. However it is not recommended to enable this option when working with
supported file systems astakes more time to accomplish the operation.

1 Skip OS auxiliary filesviark the checkbox to skip OS auxiliary files (like pagefile.sys, hiberfil.sys, etc.), thus
reducing the operation time and the resulted size of the backup image.
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Hot Processing Options

% Hot processing options

V| Enable hot processing
Hot processing technology
Microsoft Volume Shadow Copy Service _'.}

Microsoft Volume Shadow Copy Service is a relable technology designed
to back up volumes being locked by numerous active transactions of VSS
supporting applications. Microsoft VSS technology requires over 300 MB of
free space on any mounted NTFS volume for temporary data. This
technology is provided for Windows XP and newest Windows versions, but
unavaiable for old versions of Windows (38/ME/NT/2000)

Addtional options
Aways use hot processing

@ Use hot processing only when padttion is locked
Hot processing temporary drive

¢ [

Number of attempts to stat VSS 3

Timeout between attempts {n seconds): 120

V| Switch between Hot Processing technologies

In this section you may configure the hot processing mode:

1 Enable hot processingViark the checkbox to enable the so called hot data processing mode that is specially
designed tgprocess data without restarting your operating system.

1 Hot processing technologyrom the puldown list you can select the required hot processing technology.

1 Always use hot processingelect the option to process partitions without making them locRéudls you will
be able to keep working with them as usual.

1 Use hot processing only when patrtition is locke8elect the option to use the hot processing only when
partitions are locked and cannot be processed without restarting the computer. Please ka@mirthat once
you start any operation on a partition in this mode, it will automatically be locked by the program, thus you
won't be able to keep working with it as usual.

1 Hot processing temporary driveHere you can select a disk drive that will be usestore the temporary hot
backup data (by defaui C:).

1 Attempts to start VSSHere you can set how many attempts to start Microsoft VSS the program is to do before
automatically rebooting the system and accomplishing the operation in a specialpoobde.

1 Timeout between attempts (in secondsHere you can set a time period between different attempts to start
Microsoft VSS.

1 Switch between hot processing technologigglark the checkbox to automatically switch between Paragon Hot
Processing and Microg0¥SS if one of them is unavailable at the moment.
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Partitioning Options

5 Partitioning Options

Enable 64 KB clusters for FAT16

Choosa this option to enable 64 KB clusters for FAT 16 partitions. With this
satting. you will be able 1o create FAT 16 parttions with capacty up to 4 GB
Please note that only Windows NT family systems will be able to access such
parttions

Confimations
V| Ask for volume [abel before panttion delete

Ask confirmation when converting FAT16to FAT32

This section contains a set of options that will be taken into account during partitioning operations:

1 Enable 64 KB cluster size for FATMark the checkbox to enable 64KB clusters for FAT16 partitions. Thus you
will be able to create FAT16 partitions up to 4GB in size

Due to the maximum cluster size of 32KB for Windows 95/98/ME or MS DOS, FAT16
partitions larger than 2GB are not reliably accessible under these operating systems.

1 Request confirmation before partition deletionMark the checkbox to astate an additional security
mechanism. Thus when going to delete a partition you will be automatically requested to enter its label.

1 Request confirmation when converting FAT16 to FATBRrk the checkbox to automatically request
confirmation before conveimg FAT16 to FAT32. There are a number of situations when this kind of conversion
is the only way out to accomplish the operation. For instance, you are going to migrate your system to a large
hard disk with the proportional resize of existing partitionhiat is very convenient. As a result you can get
original FAT16 partitions go beyond the 4GB limit. Thus without conversion to FAT32, this operation will in no
way be possible to accomplish. The same goes for any copy hard disk/partition or restoréskgdrtition
operation involving an extra upsizing.

Virtual Mode Options

@ Virtual mode options

Operations mode
V| Alow virtual mode
Set this option on to camy out 3l the operations vitually. You will be able

to commit the changes or rolback al of them or the last one. ¥ you switch
this option off, the operations will be camied out immediately

Close progress dialog automatically
Set this option on to automatically close the progress dialog after committing
the changes.

In this section you may configure the virtual mode:

1 Allow virtual mode Mark the checkbox to enable the vigumode. It is an effective way of protection from any
troubles, since no operation will be executed until confirmation, thus giving you a second chance to weigh all
pros and cons of this or that particular operation.

A We strongly recommend you to enabkhis mode.

1 Close progress dialog automaticalliylark the checkbox to automatically close the progress dialog after
accomplishing operations.
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Log Files Options

"o, Log files options

Choose a storage e span for the stubact log file, Pleaase note_ once the defined

pesiod has been expired, the file wil be emptied
@ Infinite

Mrmimal
Custom

In this section yoean specify a storage life span for tebact.log file
1 Infinite not to empty the file ever;
1 Minimal to have the file emptied all the time;

1 Customto set a certain storage life span for the fillease note, once the defined period has been expiresl, th
file will be emptied.

We strongly recommend you not to choose the Minimal option, as in case of having
A problems with the program, our Support TeamwoQd 6S o6t S G2 add
help you out.

Getting Information on Disks

The main tool to view idepth information on the properties of hard disks is sk Map It represents the actual state
2T (KS Oy diddsl SND
Generally the hard disks are represented on the map by rectangular bars, which also contasizaddibars. The small

sized bars represent logical disks (partitions). When you select ademgp bar, th&Explorer Badisplays information
about the disk in a bright, graphical form.

Basic Hard Disk 1 (VMware, VMware Virtual S SCSI Disk Dev)

Type: Intemal Hard Disk Drive
Total size: 16GB
Sectors per track: 63
Heads: 255
Cylinders: 2088

The model and serial number of the disk serve as the title of the browsed page. The diskdaymwin in form of a
circular graph, where the color of a sector corresponds to a file system of an appropriate partition. On the right you m
see a table, which contains the following information:

1 Type of hard disk (basic or dynamic),
1 Total size (in GB

9 Information on geometry of the disk (amount of sectors per track, heads and cylinders).
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Windows 7 (C:)
Volume letter: (C) Serial number: AQF4-BASD-FABA-755E
Volume label: Windows 7 Partition 1D: <07 NTFS
Type: Prmary NTFS version: 301
Fle system: NTFS Volume size: 114GB
Root entries: 16 Partition size: 114GB
Sectors per boot: 8 Used space: 74GB
Seciors per cluster: 8 Free space: 4GB
Activity: Yes

Hidden state: No

» Format Partition
é This wizard helps you to format the selected partiion
Waming: Formatting will erase all the data on the parition |

% Delete Partition
w This wizard helps you to delete the selected parition
Waming: All the data on this partition will be lost. You can recover deleted paditions with Undalete Partition Wizard,

(? Copy the selected partition
< Create a copy of the pariion, Anew parttion will be crested and o the data will be copied there.
. You can create an exact copy. or copy only the area that is occupied by data

When you select a smadized bar (i.e. corresponding to a logical disk) the EepBar will display information on it as
well. The page title will contain a drive letter, which is assigned to the disk. The disk layout graph will be colored in
accordance with the volume ratio of the used space to the free space (the light colored)s&bmtable on the right

will contain the following information:

1 Volume label (if available),

1 Type of the logical disk,

1 File system (represented by the color of the graph and the selected bar),
1 Total size, used space and free space (in GB or MB).

Below here is a list of wizards, which may be called for this disk. All default values of parameters will correspond to tl
disk settings.

Copy Tasks

In this chapter you will find all the information necessary to make a copy of a hard disk or a separatenpartitio

Cloning Hard Disks

You can clone a hard disk of any file system. During the hard disk copying process, the program moves controlling
records of used partitioning scheme, the bootstrap code andRona { LI NI AGA2yad ¢KIF GQa 4|
subgituted by simply copying all edisk partitions.

Copy Hard Disk Wizard

The Copy Hard Disk Wizard is a traditidika wizard. By going through its steps, you configure all the necessary
settings to launch the copy operation. To minimize the possibifimaking any mistake, the wizard provides auxiliary
information on every single option. Moreover you can get adepth description to any setting, control, or field of the
wizard just by clicking the hint button and then the object you need.

A You need at least two hard disks to carry out this operation.

Startup

There are several ways to start the Copy Hard Disk Wizard:
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Express Launcher
9 Click theMigration button and then selecMigrate Hard Disk
Launcher
f Inthe MainMenu:seleét AT I NR&a B / 2L® | FNR 5AaiX
I Onthe Common Tasks Bar: click @@py Hard Diskem of the Wizards menu.
1 Inthe Toolbar: click th€opy Hard Diskutton.

Setup
The wizard offershte following steps to accomplish the copy hard disk operation:

9 The hard disk to copySelect a hard disk you want to copy.

On this page, you can choose a hard disk you would like to copy. All partitions from this hard disk will be copied
to the destination you will choose on the next page.

Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev)
lg_))locdnsk(C)

N

BaacHadD* 1 (VMware, VanMukS SCSI Disk Dev)

I ©) Local Disk (E) l locIBas:c Hard o:su v Mware, VMware Virtual S SCSID
> GENTT G T TENZ2GE

9 The target hard diskSelect a hard disk (if several)ava all data of the source disk will be copied to.

Select a target hard disk. Al data from the source hard disk will be copied there. During copy operation, target
disk content wil be deleted

:Bau‘cﬂa'du*O(VNwae VMware Virtual S SCSI Disk Dev)

I @) Local Disk <) [Basnc Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dev)]

493 9 GB NTFS

1 Copy parametersThe wizard enables to specify the following options:

Copy options:
HOD raw copy

Parttions raw copy
V| Migrate 1o Retained GPT
Resize options:
V| Remove free blocks between patitions
V| Copy data and resize paditions proportionally

N, Select the option £ you copy 10 3 hard disk of over 2TB in size. for caly GPT (GUID
) Pattion Table) nstead of MBR (Master Boot Record) enables 10 use all dsk space of this
type of hard dskcs

o
\

(e »
h

Copy options

- HDD raw copyo copy the hard disk in the secttwy-sector mode, thus ignoring its information structure (e.g.
unallocated space or unused sectors of existing partitions will be processed as well). This can help to avoid
problems with hidden data created by certain applications or the system administrator. However, it will take

more time to accomplish the operation.

- Partition raw copyto copy the ondisk partitions in the sectdoy-sector mode to successfully process
unknown file systems. However it is hot recommended to enable this option when working with supported file

systems as it takes more time to accomplish the operation.
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- Migrate to Retained GPalso known as Hybrid GR®)create on the target dis& speciatombined GPT+MBR
partitioning scheme, where the first three partitions except for EFI (GPT service partition) are synced between
GPT and MBR. This synced partition map provides an avenue, for instahoetfog 32bit Windows Vista/7
ona22TB+dignO2 YLIzi SNE O2y (iNRffSR o6& (G(KS 2fR .Lh{® LG
on a GPT disklease note, this option is only available when the target HDD is larger than 2.2TB.

A Migrate to Retained GPT option is only available when the target HDD is larger than 2.2

Resize options

- Remove free blocks between partitionsot to keep blocks of free space between partitions on the targeted
hard disk.

- Copy data and resize partitions proportionaltp make the program proportionally change the size of
partitions keeping their relative order intact. The option can be useful when upgrading the hard disk to a large
one.

Result

After the operaton is completed, you receive a fully functional duplicate of the existing hard disk.

To make a Win2K+ operating system bootable on different hardwanlease additionally
complete theP2P Adjust OS Wizard

Available operation scenarios:

9 Migrating system to a new HDD (up to 2.2TB in size)

1 Migrating system to a 2.2TB+ HDD

Cloning Partitions

You can duplicate partitions to protect oneself from downtime in case of a system malfunction or for cloning sample
partitions. The program enables to duplicate all partition data inidlgdiles, the exact structure of directories and file
system metadata (location of files, security information, access quotas, etc.).

The Copy Partition Wizard will help you copy a partition of any file system. To minimize the possibility of making any
mistake, the wizard provides auxiliary information on every single option. Moreover you can gedeptlindescription
to any setting, control, or field of the wizard just by clicking the hint button and then the object you need.

Startup

There are several ays to start the Copy Partition Wizard:
Launcher
 Inthe MainMenu:sele@ AT I NRa B / 2L tFNIAGAZ2YX

1 On the Common Tasks Bar: click @apy Partitionitem of the Wizards menu.

Setup

The wizard offers the following steps to accomplish the copy partitiomaijms:

9 The patrtition to copy Select a partition you want to copy.
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On this page you can choose a volume to copy

Basic Hard Disk 0 (VMware, VMware Virtual S SCSI Disk Dey)

l ©) Local Disk (C:)
493 9GB NTFS

Basic Hard Disk 1 (VMware, VMware Virtual S SCS1 Disk Dey)

W @) Local Disk (E2) I ©) Local Dis... Q) - I l @) (Unallo
" 34GBFAT3Z 24GB NTFS 14G.., 22GB

9 Destination disk Select a hard disk with enough unallocated space to perform the operation.

The wizard will creste a copy of Local Disk (F:) from Basic Hard Disk 1 (VMware, VMware Virtual 5
SCS1 Disk Dev)

The copy will be created on Basic Hard Disk 3 (VMware, VMware Virual 5 SCS51 Disk Dev)
Plaasa sslect whene to create a copy:

Basic Hard Disk 3 (VMware, VMware Virual 5 SC51 Disk Dev)

I &) (Unallocated)
13.3GB

The program enables to copy a partition to a block of free space, which is emgdan the
partition itself, taking into account only actual amount of data.

1 Copy parametersThe wizard enables to specify the following options:

Your hard disk after changes

Basic Hard Disk 3 (VMware, VMware Viduad 5 5C51 Disk Dev)

I @) (Unallocated)

ol |

Sl

Where to place a copy

Please speciy the size of the new partiion IE24  F9MB - 20473 MB
Please specy size of free space before the padition: [ * 0 ME - 20,434 MB
Please speciy size of free space affterthe pardition: 16849 & 0 MB - 20,426 MB.

- Partition size Definethe size (in Mb) of the copied patrtition.

- Free space beforeDefine the position (in Mb) of the copied partition relative to the beginning of the available
range of disk space.

- Free space afterDefine the amount of trailing free space (in Mb) at éral of the available range of disk
space.

Partition size and position may also be defined by using the desgldrop technique. To do
that, just carryout the required operation on the Disk Map.

Result

After the operation is completed you receive a fully functional duplicate of the existing partition.

To make a Win2K+ operating system bootable on different hardware, please additionall:
complete theP2P Adjust OS Wizard
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Partition Management

In this chapter you will find all the information necessaryaorg out partitioning operations supported by the program.

Basic Partitioning Operations

Here you can learn how to accomplish basic partitioning operations (create, format, delete).

Creating Partitions

The program provides the ability to create a new panti by using the DOS partitioning scheme. This operation can be
accomplished either with th€reate Partition Wizardr the Create Partition Dialog

Restrictions
1. Do not use the Crea Partition function in order to undelete the last deleted partition.

2. The program cannot create new partitions on Dynamic Disks. The current version of the program supports on
hard disks that use the DOS patrtitioning scheme (in Windows 2000 and XRliglesare named Basic Disks).

3. According to the rules of the DOS partitioning scheme, the following combinations of partitions cannot be
created:

- Two Extended Partitions on one hard disk
- Five or more Primary partitions on one hard disk

- Ifthere is an Extested Partition on the disk, only three Primary partitions are allowed

4. The program allows creating new partitions only within blocks epartitioned space. It cannot convert a free
space on an existing partition to a new partition.

Create Partition WizardStartup
There are several ways to start the Create Partition Wizard:

Launcher
f IntheMainmenu:sele@ AT I NR& B / NBIGS tFNIAGAZYX
1 Onthe Common Tasks bar: click eate Partitionitem of the Wizards menu.

Dialog Startup
In order to start the operatiolyou should take the following steps:

Launcher
1. Select a block of free space on the Disk Map;
2. Call the Create Partition Dialog to set up the operation. There are several ways to do it:
9 Select in the Main MenwPartition > Create Partition

9 Call the popup meanfor the block of free space (right click of the mouse button) then select the menu item:
Create Partition

Create Partition Wizard Setup

The wizard offers the following steps to accomplish the operation:
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1 Partition destination Select a hard disk (if tre@mputer has several hard disks) and then choose position for
the future partition on the disk: at the end (preferable), at the beginning or somewhere in the middle between
other partitions.

i this paoe pou can salest hard disk and tha place whens 1o create B rew pantian
Basic Hard Disk 0 (VMware, VMware Virtual 5 5C5] Disk Dev) -
I ) Local Disk (C7) I ) data ()
282958 NTFS 217 GE NTFS

Basic Hard Disk 1 (YMware, VMware Virtual 5 5C51 Disk Dev)

I @) Local Disk (%) L

Basic GPT Hard Disk 2 (WMware, VMware Vilual 5 SCS51 Dizk Dev)

I h. I E_,l {Unallocated)

Thc pnr'lltll:n il be created "-trt] F |

Lise the buttons to mowve the marker or drag marcer by mouse. A new parition will be created whers sl
the markeris

By default, the program allows you to create a new partition only as the last primary or €

Q the last logical drive within the extended partition. However, by activating the advance
mode on the first page of the wizarglou can remove this restriction that in its turn might
result in some boot problems.

1 Partition size There is no restriction on size of the future partition, merely depending on space available on the
hard disk.

If there is not enough free space in onledk, the wizard enables to redistribute free space, joining all free
space blocks together into one united block and moving partitions when necessary. If the total amount of free
space is still not enough, it is possible to split a fragment of spacednenof the existing partitions, thus

resizing it.

Yowr hard disk: before the changes

|Basic GPT Hard Disk 2 (VMware. VMware Virtual 5 5CS1 Disk Dev)

. I I @) (Unallocated)

our hard disk after the changes

Basic GPT Hard Disk 2 (WVMware, Vidware Virloal 5 5051 Disk Dew)

I I @) Local Disk (%)

If a partition to resize is locked and cannot be processed, the wizard makes the system
reboot to create thepartition and then automatically boots the system again. (The
rebooting mechanism is different for different versions of Windows.)

You can also choose whether the future partition will be primary or logical by marking the appropriate
checkbox.
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9 Partition properties. On the next page of the wizard you can set a number of additional parameters:

Your hard disk sfler the changes

Basic GPT Hard Disk 2 (VMware, VMware Virtual 5 5C51 Disk Dev)

I l W New Volume (E:)

Wolume [abal: | MNew Volume
Assign the folowing drive letter: | E ':l

- Partition type. From the pulidown list select a file system thewly created partition will be formatted to,
otherwise the partition will remain unformatted (so that it will not be ready to use).

- Volume label Enter a label for the selected partition in this textual field. It is an irrelevant parameter usually
usedfor drive identification.

- Surface test levelDefine the level of the surface check to make the program find bad and unstable sectors ar
mark them unusable in the file system metadata.
Dialog Setup

Initially the program suggests some consistent valoesll parameters. In most cases, you can just press the Yes
button to confirm the operation.

B |3
Are you sure you wanlt lo create a new parlition on disk 37
You are about to create a new parition in (Unallocated). 19.9 GB arca. Flease select size.
position and file sysiem of the new partition.
Basic Hard Disk 3 (WVMware, VMware Virdual 5 5C5]1 Disk Dev)
I 1) New Volume (H:) I
19.9GE NTFS
Create new pastiion 2s: Primary parttion [
Flease spacify new partibon size 20479 - TMB-20473 MB
Please speciy size of free space befors the parition: 0 * OMB - 20,465 MB
Please specify size of free space afterthe patition: 0 % OMB-20472 ME
Please select file system for new partition: | NTFS El
Flease anter new volume label: HNeaw Voluma
Flaasa spacify dive letter H EI
%) [More options l Yes ][ Mo |

1 Define whether the partition will be Primary, Extended or Logic#ou ca choose the desired partition type
from the pultdown list. As a matter of fact, the available alternatives fundamentally depend on the selected
block of free spacewithin the Logical free space, only Logical partitions can be created; Within the P fiear
space, both Primary partitions or the Extended Partition can be created.

1 Partition Size Define the size (in Mb) of the new partition.

1 Free space beforeDefine the position (in Mb) of the new partition relative to the beginning of the block of free
space.
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1 Free space afterDefine the amount of trailing free space (in Mb) at the end of the new partition.

Partition size and position may also be defined by using the desgl-drop technique. To do
that, just carry out the required operation on the Bk Map. The virtual operations are to b
available.

1 File system for new partitionFrom the pulidown list select a file system the newly created partition will be
formatted to, otherwise the partition will remain unformatted (so that it will not be reaalyise).

1 Volume label Enter a label for the selected partition in this textual field. It is an irrelevant parameter usually
used for drive identification.

1 Drive letter assignmentThe puldown list contains vacant drive letters that can be associatél the newly
formatted partition.

In addition, there is the possibility to make further detailed settings (although the default values will do in most cases)
To activate the advance mode, you need to click the More options button at the foot of the giedeg Depending on
the chosen file system, the following options become available:

¥ Usa 05 busk in format routine
Flease select number of sectors per cluster: | 8 [=]
Please selact number of sectons per boot

Plaase select number of root entries
l‘HﬂStQﬂ:: defaults
1 Use OS buittn routine. Mark the option to restrict the available valuascording to the used OS.

1 Whether the surface test will be performedDefine the level of the surface check to make the program find bad
and unstable sectors and mark them unusable in the file system metadata.

9 The amount of sectors per boofhis parameteis available exclusively for FAT16 and FAT32 file systems. Set
the number of sectors to be reserved for the boot area on the partition with this spinner control.

9 The amount of root entriesThis parameter is available exclusively for FAT16 file systemeSaaximum
amount of files/directories to be placed in the Root Directory on the FAT16 partition.

9 The amount of sectors per clusteDefine the Cluster Size for the formatted partition with this spinner control.

A Number of available options depends dhe selected file system type.

Result

After the operation is completed you receive a fully functional partition.

Formatting Partitions

Any partition should contain some file system to be used for keeping data. The process of installing a file system is
commonly known as formatting. A huge variety of file systems have been developed these days.

Supported File Systems

The program provides the ability to format partitions of the following file systems:
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-FAT12 & FAT16
- FAT32
-HFS+
-NTFS
- Ext2
- Ext3
- Ext4
- Linux Swap v. 2

This operation can be accomplished either with the Format Partition Wizard or the Format Partition Dialog.

Wizard Startup
There are several ways to start the Format Partition Wizard:

Launcher
 IntheMainmenuselec? AT F NRa B C2NXIF G tIFNIAGAZ2YX
M On the Common Tasks bar: click trermat Partitionitem of the Wizards menu.

Dialog Startup
In order to start the operation you should take the following steps:

Launcher
1. Select a partition on the Disk Map;
2. Call the Form@aPartition Dialog to set up the operation. There are several ways to do it:
9 Select in the Main MenwPartition > Format Partition

9 Call the popup menu for the selected partition (right click of the mouse button) then select the menu item:
Format Partition

Wizard Setup

The wizard offers the following steps to accomplish the operation:

1 Partition to format. Select a hard disk (if the computer has several hard disks) and then the required partition t
format.
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On this page., you can choose a volume you would like to format
Basic Hard Disk 0 (VMware, VMware Vitual S SCS1 Disk Devy)

‘. @) Local Disk (C}) y l @) data (Z)

2823GBNTFS | 217GB NTFS

Basic Hard Disk 1 (VMware, VMware Virtual S SCSI Disk Devy)

l ©) Local Disk (*)
433.3GB NTFS

Basic GPT Hard Disk 2 (VMware, VMware Virtual S SCSI Disk Dev)

I I ©) (Unallocated)

A As a result of this operation contents of the selected partition will be lost.

9 Partition properties On the next page of the wizard you can set the following partition parameters:
Yowr hard disk after the changas

Basic Hard Disk 0 (WVMware, Viware Vidual 5 SCS1 Disk Dev)

I @) Local Disk (C) l @) data (Z)
Pasn o ST |

Wolume label; | Mew Volume

- Partition type. From the pulidown list select the desired file system type. In fact, the program displays only
those file systems that can correctly be placed to the selected partiiidimg its capacity into account.

- Volume label Enter a label for the selected patrtition in this textual field. It is an irrelevant parameter usually
used for drive identification.
- Drive letter assignmentThe puldown list contains vacant drive lettethat can be associated with the newly
formatted partition.
In addition, there is the possibility to make further detailed settings (although the default values will do in most cases)
To activate the advance mode, you need to mark the appropriate optidhe foot of the page. When it is marked, the
next page enables to define:
7] [Use O buk in fomat routine |

Please salact sectors par cluster

|
-

1 Use OS buitn routine. Mark the checkbox to restrict the available values adicg to the used OS.

1 Whether the surface test will be performedDefine the level of the surface check to make the program find bad
and unstable sectors and mark them unusable in the file system metadata.

1 The amount of sectors per boof his parameter iavailable exclusively for FAT16 and FAT32 file systems. Set
the number of sectors to be reserved for the boot area on the partition with this spinner control.

1 The amount of root entriesThis parameter is available exclusively for FAT16 file system.eSaattimum
amount of files/directories to be placed in the Root Directory on the FAT16 partition.
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1 The amount of sectors per clusteDefine the Cluster Size for the formatted partition with this spinner control.

A Number of available options depends on theelected file system type.

Dialog Setup

Initially the program suggests some consistent values for all parameters. In most cases, you can just press the Form:
button to confirm the operation.

: * Are you sure you want to format volume (F:)?

You are about to format volume (F:) [No label]. NTFS. Your computer may
no Jonger boot or work comectly

Please select new file system:  [ZNACHINNN ~ |
Please enter new volume label: | New Volume

¥) More options ‘ Format | | No

1 File systemFrom the puldown list select the desired file system type. In fact, the program displays only those
file systems that can correctly be placed to the selected patrtition, taking its capacity into account.

1 Volume label Enter a label for the selected partition in this textual field. It is an irrelevant parameter usually
used for drive identification.

In addition, there is the possibility to make further detailed settings (although the default values will dsircases).
To activate the advance mode, you need to click the More options button at the foot of the dialog page. Depending ol
the chosen file system, the following options become available:

#| Use OF built in format routine

Plaase sslact number of sectors per cluster: | 128 [=]
Pleass sslect number of sectors per boot:

Fleass salect number of oot entries:

Restone Ma-.ts;

1 Use OS buitn routine. Mark the checkbox to restrict the available values according to the used OS.

1 Whether the surface test will be performedDefine the level of the surface check to make the program find bad
and urstable sectors and mark them unusable in the file system metadata.

1 The amount of sectors per booflhis parameter is available exclusively for FAT16 and FAT32 file systems. Set
the number of sectors to be reserved for the boot area on the partition with $pinner control.

1 The amount of root entriesThis parameter is available exclusively for FAT16 file system. Set the maximum
amount of files/directories to be placed in the Root Directory on the FAT16 partition.

1 The amount of sectors per clusteDefinethe Cluster Size for the formatted partition with this spinner control.

A Number of available options depends on the selected file system type.
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Result

After the operation is completed you receive a fully functional partition formatted to the specifeegystem.

Deleting Partitions

With the Delete Partition Wizard or the Delete Partition Dialog you can delete a partition on a hard disk partitioned wi
the DOS partitioning scheme. Unlike the majority of other utilities (Windows Disk Manager inclindepijpgram can

not only remove references to the deleted partition from the Partition Table, thus making it unavailable for the
operating system, but also enables to irreversibly destroy its data. This feature will guarantee security of your person
information.

Wizard Startup
There are several ways to start the Delete Partition Wizard:

Launcher
 IntheMainmenu:sele@ AT I NR&d B 5SfSiGS tIFINIAGAZ2YX
9 Onthe Common Tasks bar: click ihelete Partitionitem of the Wizards menu.

Dialog Startup
In order to startthe operation you should take the following steps:

Launcher
1. Select a partition on the Disk Map;
2. Call the Delete Partition Dialog to set up the operation. There are several ways to do it:
I Select in the Main MenwPartition > Delete Partition

9 Call the popp menu for the selected partition (right click of the mouse button) then select the menu item:
Delete Partition

Wizard Setup

The wizard offers the following steps to accomplish the operation:

1 Partition to delete. Select a hard disk (if the computer hagesal hard disks) and then the required partition to
delete.
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On this page. you can choose 3 volume you would ke to delete
Basic Hard Disk 0 (VMware, VMware Virtual S SCS1 Disk Dey)

l«_a;tocduak(c:) lt_)Jdda(Z:)
2829 GB NTFS 217 GB NTFS

Basic Hard Disk 1 (VMware, VMware Virtual S SCS1 Disk Dev)

l @) Local Disk (")
439.3 GBNTFS

Basic GPT Hard Disk 2 (VMware, VMware Virtual S SCS1 Disk Dev)

I I ©) (Unallocated)
5698 GB

‘ ! . You are sbout o destroy a bootable partition!
52

A As a result of this operation contents of the selected partition will be lost.

1 Merge free blocksAs aresult of the operation you may get several blocks of the unallocated space on the hard
disk. So choose whether to merge them all and place at the beginning of the disk or at the end by selecting th
required operation from the puitlown list.

Merge fres blocks options
Do mot marps fres blocks s, |:|

Marge fraa blozks & the and o the disk

Merpe fres blocks at the beginning of the disic

Dialog Setup
Initially the program suggests you just to remove references to the selected partition from the Partition Table.

N = )

'J-"‘Z Are you sure you want to delete volume (F:)?

w You are about to delete volume (F:) [No label]. NTFS. Your computer may
no longer boot or work comactly

1[0 not ask volume label next tme |

1 Enter the volume label to confirm deletingro confirm deletion of the selected partition, enter its Volume
Label. The current volume label is displayed above.

91 Do not ask volume label next timéviark the option to inhibit confirmation next time you start the dialog.

Result

By default, the operation takes only a fraction of a second. However, the program waits until Windows completes the
modification of the disk layout.

Advanced Partitioning Opera tions
Here you can learn how to accomplish advanced partitioning operations (merge, redistribute free space, undelete, et
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Undeleting Partitions

When simply deleting a partition (without additional wiping) disk management software only removes refeterita
the Partition Table, thus leaving the possibility to recover it later.

The program enables to find and recover these patrtitions. A restored partition will be fully functional, as long as other

partitions were not created, moved or exceeded thskdspace occupied by that partition. That is why the program
offers this function only for blocks of free space.

The operation can be accomplished with the Undelete Partition Wizard.

Startup

There are several ways to start the Undelete Partition Wizard:

Launcher
f IntheMainMenu:sele@ AT | NRa B ' yRStSGS t I NIAGAZ2Y&X
1 On the Common Tasks Bar: click thedelete Partitionitem of the Wizards menu.

9 Select a block of free space on the Disk Map and clicRéwever Lost Partitiongem on the page that appears
in the Explorer Bar.

9 Call the popup menu for the block of free space (right click of the mouse button) then select the menu item:
wSO2@SNJ [2ai tFNIAGAZ2YAX

Setup
The wizard offers the following steps to accomplish the undelete partition operation:

1 Free blaks to scan for lost partitionsChoose a free block from a tréike list of available hard disks.

Chick: the check box next to any hard disk dive or frese block you want (o eommine

Name Type
= Bl My Computer WMy Compuier
- [¥] [5] Basic Hard Disk 3 (Viware, Vidware Vidual 5 SCSI Diske Dew) Imtemal Hard Di

EllSunsocmed [

The summary =z of fragment (3) to analyze is 19.9GB

1 Search methodBy default, the wizard selects the fastest search méttoo your operating system. In most
cases that will do to find any accidentally deleted partition. However if you're under Windows XP for instance
(the Conventional Search option is selected), but the deleted partition you're looking for has been evighted
the Disk Management utility under Vista, the wizard won't be able to find this partition, unless you manually

select the appropriate option (Quick Search for Partitions Created by Vista or Later OS). Moreover if the wizal

still fails to find the paition you need, you can select the Thorough Search option to scan every single sector i
the specified search area to get the most accurate results.
Choose how to look for the deleted partitions:
[ Quick search for partitions. created by Vista or later OS
o Conventional search
Thorough search
¥ Show file systems search options
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To know more on the available search methods, please use the context sensitive hint
system.

1 File system filter By default, the wizard will search for all knowla 8ystems. However, by clicking on the
appropriate option on the second page of the wizard, you can specify only those file systems you need.

2 Hide file systems search options
| Al known file systems |
FAT and FAT32 fie systems
V| NTFS file system
Uinux B42 and B3 file systems
0S/2 HPFS file system
Other funkisted) file system
To begin search, cick Next

1 A partition to undelete(if several). By default, the program searches records of any deleted partition ever
existed on the selected block of free space. So you can get several partitions to choose from.

E} Search delsted parttions from sactor; 40 1o sacior 2797

The following partitions have been found:

File system . Type .Capmh' Used Space [ % Used
T NTFS Primary 199GB 853 MB 0
[ Stop search ]

Most likely the required partition will be found first. If so, you may abort the search operation by pressing the
Stop search button.

Result

After the operation is completed you receive a fully functional partition.

Changing Partition Attrib utes

This chapter explains how you can change partition attributes (Active flag, Hidden flag, Partition ID, Volume Label, et

Mark Partition Active/lnactive

The program enables to set an active/inactive flag for primary partitions of a hard disk.2Byt,daf operating system
will boot only if its partition is active or bootable.

In order to mark a partition active/inactive you should take the following steps:
Launcher
1. Select a primary partition on the Disk Map.
2. Call the Mark Partition Active/lnactii@ialog to set up the operation. There are several ways to do it:

- Select in the Main MenwPartition > Mark Partition as Active/lnactive

/ 2 L3 NX 3 R016 Paragod Blwvare Group. All rights reserved.



54

- Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map, then sele
the menuitem: Mark Partition as Active/lnactive

-9 [

" Are you sure you want to set the volume as active?

You are about o set the volume (F:) [No label]. NTFS as active. ¥ you already
have active volumes, this action might render your system unbootable

e

Yes l No

3. The operation will be performed immediately after confirmation.

Q There can only be one active partition on a hard disk, otherwise your operating system \
fail to boot.

Hide/Unhide Partition

The program allows you to hide/unhide primary and logical partitions. By default, aatomesystem does not mount
hidden partitions, thus preventing access to their contents.

In order to hide/unhide a partition you should take the following steps:
Launcher
1. Select a partition on the Disk Map.
2. Call the Hide/Unhide Partition Dialog to settine operation. There are several ways to do it:
- Select in the Main MenwPartition > Hide/Unhide Partition

- Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map, then sele
the menu item:Hide/Unhide Partition

3. The operation will be performed immediately after confirmation.

It is strongly recommended not to hide the system partition. Otherwise your operating
system will fail to boot.

Set Label of a Partition

The Partition Label is a small textual field (up to 11 characters) that is located in the partition's boot sector. It is
detectable by any partitioning tool and is used for notification purposes only.

In order to change a patrtition label you should take the following steps:
Launcher
1. Select a partition on the Disk Map.
2. Call the Change Volume Label dialog to set up the operation. There are several ways to do it:
- Select in the Main MenwPartition > Modify > Gange Volume Label
- On the Explorer Bar: click on the current volume label.

- Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map, then sele:
the menu item:Change Volume Label

3. Enter a label for the selected pdion.
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R ===
® Are you sure you want to change label on volume (F:)?
! Please specify a volume label for easier recognition of your volume

Please enter new volume labed: | New Volume

Yes | No

4. The operation will be performed immediately after confirmation.

Hard Disk Management

In this chapter you will find all the information necessary to carry hardagiskations supported by the program.

Converting Dynamic MBR to Basic

The program allows you to convert a dynamic MBR disk containing simple volumes into a basic one while keeping its
contents intact.

In order to convert a dynamic MBR disk into basic ymukl take the following steps:
Launcher
1. Select a dynamic MBR disk containing simple volumes on the Disk Map.
2. Call the Convert to Basic dialog selecting inthe MainMenuNR 5Aal B / 2y @SNI G2

3. Set the required number of primary partitions if nesasy. According to the DOS partitioning scheme a hard
disk can have up to four Primary partitions. If there is an Extended partition on the disk, only three primary
partitions are allowed. That is why if a dynamic disk contains several simple volumesghanp enables to
choose the number of primary partitions. The rest of them if any will automatically be converted to logical disk
within the Extended patrtition.

PR =

@ Convert dynamic hard disc to basic?

¥ the disc has more than four smple volumes, the first three of them will become
peimary partitions, and the rest will be converted to the logical ones

The hard disk after convent
Basic Hard Disk 3 (VMware, VMware Virdual S SCSI Disk Dey)

. New Volume (H:)

The resulting basic hard disk can have no more than 1 pemary parttions
Please salect how many pemary parttions the basic disk should have

The program can only process dynamic disks containing solid simple volumes (without
extension).

Converting GPT to Basic MBR

The program allows yowtconvert a basic or a dynamic GPT disk containing simple volumes into a basic MBR disk wt
keeping its contents intact.
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In order to convert a basic or a dynamic GPT disk into a basic MBR disk you should take the following steps:
Launcher
1. Select a basior a dynamic GPT disk containing simple volumes on the Disk Map.
2. Call the Convert to Basic MBR Hard Disk dialog selecting in the Main NemauDisk > Convert to Basic MBR
I FNR 5Aa1X

3. Set the required number of primary partitions if necessary. Accorditigg®OS partitioning scheme a hard
disk can have up to four Primary partitions. If there is an Extended partition on the disk, only three primary
partitions are allowed. That is why if a GPT disk contains several volumes the program enables to choose the
number of primary partitions. The rest of them if any will automatically be converted to logical disks within the
Extended partition.

-9 s
'@ Convert the basic GPT hard disk to a basic MBR hard disk?

1 ¥ there are more than four volumes on the disk, only the first three may become
primary, and the rest - logical

The hard disk after convent

Basic Hard Disk 3 (VMware, VMware Virtual S SCSI Disk Dev)
I . New Volume (H:)

The resukted hard disk should have at least 1 primary partition(s)
Please salect how many primary panitions you need

2

\_Conveﬂ ‘ No

The program can only process dynamic GPT disks containing solid simple volumes (wit|
extension).

Converting Basic MBR to GPT

The program allows you teasilyconvert a baicMBRdiskinto a basic GPdisk while keeping its contents intadthe
operation is quite safe for the edisk data, but you should know that only-6# Windows OSes since Vista are able to
0220 FTNRY (GKAa Ge&LIS -»iwindowd (e {HQOAFY 2RI AP (I FROH|
Al 62y Q0 adGFNI dzZLJ F FGSNI GKS 2LISNIX A2y Aa 20SNO®
In order toconvert a basic MBR disk to a basic @&rshould take the following steps:
Express Launcher

1 Click theAdjustmentbutton and then selec€onvertMBR Hard Disko GPT
Launcher

1. Select @asic MBmard disk on the Disk Map.

2. Call theConvert to GPT Hard Didlalog to set up the operatiohy slectngin the Main MenuHard Disk >
Convert to GPT hard disk
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0[]
A Are you sure you'd like to convert Basic Hard Disk 0 (VMware Virtual
IDE Hard Drive ATA Devi) to GPT?

Please Note! Despite the fact that al on-disk contents remain intact during the
operation, your OS may no longer boot comectly, for Windows XP 32t for instance

does not support GPT disks
"

3. The operation will be performed immediately after confirmation.

A The program can onlgonvert basic MBR disks.

Updating MBR

The program enables to overwrite the current bootable code in the MBR (Master Boot Record) by the standard
bootstrap code. This can help to repair a corrupted bootable code of a hard disk resulted from a boot virugradtack
malfunction of boot management software.

In order to update MBR of a hard disk you should take the following steps:
Launcher
4. Select a hard disk on the Disk Map.
5. Call the Update MBR dialog to set up the operation. There are several ways to do it:
- Selet in the Main MenuHard Disk > Update MBR

- Call the popup menu for the selected hard disk (right click of the mouse button) on the Disk Map, then
select the menu itemUpdate MBR

s

1 Are you sure you want to update master boot record?
— Cument MER contents for hard disk number 0 will be lost after this operation. Your

computer may no longer boot comectly
I Yes i | No

6. The operation will be performed immediately after confirmation.

Task Scheduling
Ldzi2YFGA2Y 2F 2LISNI 0A2ya OFy NBIffeée KSfLI @82dz 2dzi 6 KSE
basis as it enables to execute them withoutyauy @2 f 3SYSy i KAt S 2LJiAoad T Ay3a &2d
Setting a Timetable

Thanks to the embedded Scheduler, you can set a timetable for execution of any operation. It has two categories for
time settings (these correspond to appropriate items in theesicie type menu):

1 Initiating the operation by an event
- One time only (i.e. the Once item)
- When the system starts (i.e. the At System Startup item)
- When the user logs on (i.e. the At Logon item).

1 Initiating the operation periodically (i.e. Daily, Wédy, Monthly).
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Please specy how and when would you ke to pedomn the task

You need to select one of the variants. Depending on your choice, the scheduler displays a form that enables to set ¢
timetable.

Please specty how and when would you lios to parfom the task

Shutdown system after backup
| Generate unique names for scheduled backoups
Run the task on
09022009 5 at [12:00 AM 2
Every
1 * wesk@)on:  [] Monday Frday
Tussday Saturday
Wednesday Sunday
Thursday

Do mot run the task after:

aacily user name and password,

To run the task in the logff mode, please specify administering login info by following thi
2 appropriate link in the left lower corner of the page.

The Shutdown System on Complete option enables to automatically switch off the
computer on the successful accomplishment of the operation.

Managing Tasks

All scheduled tasks are placed in a sepaiatewhich can be retrieved by clicking the Scheduled Tasks tab in the
Explorer Bar:
Scheduled Tasks & B [k

Mame Script When to Fan
¥ Backup of MBR of hard diskc 0 scr_020909124744490pal At 1.2:00:00 AM every Mon, of every weel, starting 9/2/2009

On every task you can getdepth information, including:
1 The task name
91 The full path tahe generated script of the task
1 Scheduled time of launch
i Statistics on the last launch
1 Scheduled time of the next launch

I Used account information
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1 Comments to the task

To easily manage tasks, the program enables to arrange them according to a certagteafmstic just by clicking on the
required property.

Q This feature can be particularly beneficial when the Scheduled Tasks list contains too m
items.

You can also enable/disable, rename, delete, refresh or modify properties of the selected task.

Task Editor

With the Task Editor you can easily modify properties of scheduled tasks. To do that, you should take the following
steps:

Launcher
1. Select a tdson the Scheduled Tasks list.
2. Call the Task Editor dialog. There are several ways to do it:
- Click thePropertiesbutton on the Scheduled Tasks list.

- Call the popup menu for the selected task (right click of the mouse button), then select the menu item:
Properties.

"%, Task Properties: Backup of MBR of hard disk0 e
O Program: |C\Program Fles'Paragon Software’\Deve Backup 10 Server Edtion'grogram’scnipls exe
| Seript n Files/Parsgon Software/Drive Backup 10 Server BEdtion/scripts/scr_020909124744450 psl
[ Ea. |[ Bowse. |

Comenents Backup has been scheduled: 3/2/2009 5:47-44 AM

| Enabled

[ ok ][ ey |[ Conce

3. Inthe opened dialog window you can see two ta&eneral and Schedule. Click the General tab to modify:
9 Full path to the macraommand programinterpreter, which desdbes the scheduled task;
1 Command line for starting the interpreter (i.e. the task described in mkgrguage)
1 Comments referring to the task
1 The option of enabling/disabling the task.
By clicking the Schedule tab you can modify the task timetable.
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In order to apply the changes, you need to click the Apply button at the foot of the dialog.

Creating a Scheduled Task

You can set a timetable for execution of any operation. For backup and copy operations the program offers handy
wizards, while all the othersao be scheduled with the Save to Scheduler dialog.

To create a scheduled task you should take the following steps:
Launcher

1. Make sure thevirtual mode of execution is enablgd

2. Carry out with the program all operiahs you need to schedule;
3. Call the Save to Scheduler dialog inthe MainMéng:2 f & B { | @8

-]

)
[t

N
—~
O«
A
(0p))
puj
o
N
w
p
R

5.5 Schedule virtual operations?
g_‘.\

Al vitual operations you have made will be saved to the scheduler. No operations wil be
appled

Task name: 'Schedued Task
Please specify how and when would you ke to perform the task
@) E—)

Shutdown system after camying out the tasks

Run the task on

05/02/2009 5 a 1200 AM
Every

1 * dayls)

Do not run the task after.

er 0 and WO

Discard all operations on close l Yes ] No

4. In the opened dialog enter the required task name and specify thle tianetable;

5. The operation will be performed immediately after confirmation.

A This command is unavailable if there are no operations on the List ofddem Operations.

Scripting

The program actions can also be represented in form of a script. The script describes the appropriate operation with
macralanguage commands. There is an interpreter utli8CRIPTS.exe, which is included in the programlatiial
package. This utility works in the unattended mode, which enables to automate operations.

Startup

You have no need to write a script since the program has a convenient interface for such a task. In order to generate
script on the base of the ented parameters of the required operation, you should take the following steps:

/ 2 L3 NX 3 R016 Paragod Blwvare Group. All rights reserved.



61
Launcher

1. Make sure thevirtual mode of execution is enablgd

2. Carry out with the program all operations you need to be scripted,;
3. Call the Generate Script dialog inthe MainMertu2 2f & B DSY SNI 4GS { ONX LI X

Setup

Initially the program suggests some consistent values for all parameters. In most cases, you can just press the Gene
button to confirm the operation.

7 [
57 Generate script?
S

All vitual cperations you have made will be writhen to the script. No operations
wil be appled.

Plaase specify & name for the task script file
script_020909_125123443 pal

o Addio Task List

=) [More options Genermte Mo

9 Script file name and locationBy default, the program offers to add the script to the Task List with a name
containing its creation date and time. Unmark the Add to Task List checkbox to define ameaachland a

filename for the script file. The default file extension that is reserved for scripting files is .psl, which however ¢
be modified.

In addition, there is the possibility to make further detailed settings (although the default values wilhulust cases).

To activate the advance mode, you need to click the More options button at the foot of the dialog page, so you will be
able to define:

Please select script generation options
Alow to interact with the user

Tum this option off § you do not want to get confirmation dialogs when the script is
being camed out

v| Commi after each operation

Tum this option on to ensure the changes will be committed after each operation
v Check for emors after each operation

Tum this option on to make scnpt intemrater to check the result of each operation
Discard all operations on close

Tum this option on to dscard all the pending operations after generating the script

1 Interaction with the user. Mark the option to pause the script interpreter during the execution to prompt the

dzZa SNRa O2yFANNIFGA2Y 2NJ 20KSNJ AyLlzid hiKSNBAaAS (K
needed.

1 Commit after each operationMark the optionto commit changes after each operation.

1 Check for errors after each operatioMark the option to insert a special code in script, which checks the status
of the last executed operation and stops the script processing if there are errors of any kind.

91 Disard all operations on closeMark the option to empty the List of Pending Operations after generating the
script.
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Result

After the operation is completed you receive a new script file. It is placed into the specified destination, its features
defined in the dialog.

f This command is unavailable if there are no operations on the List of Pending Operatior

To learn more about scripts please consult the Pgma Scripting Language manual.

Extra Functionality

This chapter describes the supplementary functionality available in the program.

View Partition/Hard Disk Properties

The program enables to obtain-depth information on the properties of hard disks goattitions. Besides the general
information, such as capacity, used space or file system type it provides the possibility to get info on hard disk geome
cluster size, exact partition location, etc.

There are several ways to get properties on a pariftiard disk:
Launcher
1. Choose a partition/hard disk on the Disk Map, then select in the Main MeduNIi A G A 2 Yy K| | NR; 5 A

2. Call the popup menu for the selected partition/hard disk (right click of the mouse button) on the Disk Map, the
select themenu item:t N2 LISNJi A S & X

-2 e
General| | File System Info ]ﬁdvmced

Local Disk (C:)

Volume: label: [No label)
File system: NTFS
Type: Prmary
Capacity: 4393GB
536.868,814.848 Bytes
1.048.571,904 Sectors
Used by data: 953GB(1%)
10,016,497 664 Bytes
19,563,472 Sectors
Free space: 4306GB (39%)
526.852,317,184 Bytes
1.029.008,432 Sectors

In the opened dialog information will be grouped according to its properties, thus by clicking tabs you can get
information you need.
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Volum e Explorer

Volume Explorer is a special tool to browse and export contents of the local mounted/unmounted volumes formatted
FAT16, FAT32, NTFS, Ext2FS, Ext3FS, ReiserFS file systems. Besides it enables to access Paragon backups as re
folders to exforer their contents or to retrieve certain files.

Launcher
To launch the Volume Explorer you should diedk Viewtab in the Explorer Bar and then chodgelume Explorer

Disk View | Scheduled Tasks | Archives | Help

Mame Size Modiied
| @ CI] CO/DVD Drives
(8 = O Hard Disks
#- [Z] 1. Viware_ Viware \irual 5 SC5 Disk Devi 500 GB
5 [5] 2. Viware_ VMware Vitual S SCSI Disk Devi 10GB
#- {8 1. Prmary FAT22 [E) 34GE
) B2 Primasy NTFS F) 24GB
+ 9272009 4:19:34 AM
TP — mn
o Tk 1.4GB
#- B9 4. Primary Linuce Swap 509.8 MB
1 [Z] 3. VMware, VMware Vitual 5 SC5I Disk Devi 80GB
: 4 [F] 4. VMware_ Viware Vitual § SC51 Disk Devi (GPT Disk)
B @ O Vietual Drives

Call the popup menu for the selected file/folder (right click of the mouse button) to export it to some other location
(local or network drive, etc.).

@, Select a destination folder for the export operation |2 |f3e]

lookin: | FllocaiDeskic) [+] & % 2

@ I Address; C./
L [ Mame Date

48 calDskc) |
gj () DVD AW Dive (D)
[E] Local Disk )

+
Hetwork Placss # [Z] Local Disk )
+

[Z] Aechives @G
[E] New Viohume (H)

o) [

File Transfer Wizard

File Transfer Wizard is designed to make such operations as copying of separate files/directories or burning of them
CD/DVD as easy and convenient as possible. It may be of particular use in case of a system malfunctiitleause

a virus attack or files corruption, in order to get the system back on track again. Besides it provides access to Parago
backups as regular folders to browse through their contents or copy required files.

Startup
There are several ways to stéine File Transfer Wizard:

Express Launcher
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9 Click theBackup and Recoveyutton and then selecTransfer Files
Launcher
1 Select in the Main Menutools > File Transfer Wizard

1 Select theTransferFilesitem of the Wizards menu on the Common Tasks Bar.

Sdup
The wizard offers the following steps to accomplish the transfer operation:
9 Place to look for files/directoriesSelect a source disk from the pddwn list in the left pane of the page. The

program enables to process both mounted and unmounted (withdrive letter assigned) partitions. Besides it
is possible to map a network drive.

Source
[5] Local Disk ) ' '} o X ¥

N (©)DVD RW Drive (D) *
[5] Local Disk E) -
(5] Local Disk F)

(5] Archives G)
(5] New Volume (H)

@) Physical partitions
vy, NEW VOLUME, Disk 1

I Network places 3
Il Network -

1 Object(s) of operation Choose files/directories you want to copy and place ther@lipboard by pressing the
Add button. To delete a file/directory from the Clipboard, select it in the Clipboard pane and press the Remov:
button. You can also create a new folder, rename or irreversibly delete existing files/directories of the éeft pan
by pressing the appropriate buttons.
Clipboard Source
Name  Source Path [Z] Local Disk (F) ] @R ¥
images F/images/

Name -
O TG DYy

% hibedi sys
) %, pagefie sys
» [5] somecmd emd
DVD RW Drive (D)
= [5] Local Disk (E)
[F] Locat Disk (F)
l—

System Volume Information
Total data size: 132.8 KB

A Files/directories déeted from the Clipboard remain intact on source disks.

9 Destination to store the object(s)The File Transfer Wizard allows copying data to local or network drives, to
physical partitions (without drive letters assigned), or burning them to CD/DVDs. €timoway the data will
be stored.
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There are several ways the Wizand can store your data. Plese selact how would you ke to save the: data:
@ | Save data to local/hetwork drives. |

Crvenwribe masting files

Save data to physical pariions
Bum the data to CD or DVD

1 Revision of changesThe Transfer Summary page provides structurally divided information on all the actions
made in the wizad. Check the changes and come back to any step of the wizard (if necessary) by following the

required hyperlink.
Please overview the transfer options. You can retum to the comesponding page and change the options by clicking on title
hyperdnks

Qbiects to transfer
Object(s) selected: 1
Total data size: 132.8 KB (136,024 Bytes)
Transfer destination
Destination path: C/
Space available on destination: 4506 GB (526.821.834 752 Bytes)
Overwrite existing files: No

Result
After the operation is completed the reqeid data will be placed into the specified destination.
Available operation scenarios:

1 Copying of data from the corrupted system disk to another hard disk

1 Burning of data from thearrupted system disk to CD/DVD

Mount Partition

The program enables to assign or remove drive letters of existing formatted partitions.

Assign Drive Letter
In order to mount a partition you should take the following steps:
Launcher
1. Select a partition on th Disk Map.
2. Call the Add Drive Letter dialog to set up the operation. There are several ways to do it:
- SelectintheMainMenud: F NI AGA2Y B ! daiA3ady S5NAGS [ SiGdSNX

- Call the popup menu for the selected partition (right click of the mouse button) on the Ripkthken select
themenuitem! a4 A3y S5NAGS [ SiiSNX

3. Specify a drive letter for the selected partition. Initially the program suggests some consistent value for this
parameter. So you may just press the Yes button to confirm the operation.

B =5

@ Assign a drive letter?

This allows access to the volume by using the drive letter assigned. The
assignment is not recommended  the volume contains a file system not
supported by your operating system

Assign the folowing drve letter: NN ~ |

T —

/ 2 L3 NX 3 R016 Paragod Blwvare Group. All rights reserved.



66

However you can manually define the required letter by selecting it from thedputh list of available drive
letters.

4. The operation will be performed immediately after confirmation.

Remove Drive Letter
In order to unmount a partition you should take the following steps:
Launcher
1. Select a partition on the Disk Map.
2. Call the Remove Drive Letter dialog to define appropriate settings. There are several ways to do it:
- Select in the Main Mam Partition > Remove Drive Letter

- Call the popup menu for the selected partition (right click of the mouse button) on the Disk Map, then sele:
the menu item:Remove Drive Letter

3. The operation will be performed immediately after confirmation.

Modifying drive letter of the system partition will result in inability to boot the operating

f system.
After having processed partitions with installed softwarepme programs may not run
properly.

Check File System Integrity

The program allows you to check integrity of a file system. It can be used to detect possible file system errors before
performing any operation on a partition.

To start the system integritgheck you should take the following steps:
Launcher
1. Select a partition on the Disk Map
2. Call the Check File System Integrity dialog to set up the operation. There are several ways to do it:
- Select in the Main MenwPartition > Check File System Integrity

- Cdl the popup menu for the selected partition (right click of the mouse button) on the Disk Map, then selec
the menu item:Check File System Integrity

A, Check volume (C:) [No label]. NTFS for efrors?

1 Flease note that check operation needs exclusive access to the volume. You may be
asked to restart your computer to complete the operation

3. The operation will be p#ormed immediately after confirmation.
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View Logs

With a handy dialog you can study logs on any operation carried by the program. To make this job as easy as possib
the information is structurally divided, besides there is the possibility to sedittkelayout before and after an
operation, what is very convenient.

In order to view logs on carried out operations call the View Logs dialog in the Main W&oig:> View Log Files

Typical Scenarios

This chapter lists a number of the most frequently used scenarios that may be accomplished with the program. You c
find here useful recommendations and descriptions of operations.

System Migration Scenarios

Migrating Window s OS to a solid state drive (Migrate OS to SSD)

The latest SSDs do not boast high capacity, but rather smaller size and faster processing speeds over regular hard d
Plus, they are completely indifferent to mechanical impact, a feature crucial folenaimputers. These benefits are
leading more and more users to consider migratndpastOS to SSDs to giie most out of their systems.

Sq how do you migrate a Windows OS dnthdreds of gigabytes of data on one huge volumen&&D drive of 80
128GB?0ur Migrate OS to SSD Wizard can help you do that with minimal effort.

To migrate anyVindows OS since XP from a regtlard disk toa fast SS[please do the following:
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